
Dover Fueling Solutions DX Fleet User Manual
Part Number: M3052
Revision: 5

DX Fleet



IMPORTANT: Before you use this manual, make sure you have the most recent revision.
Look at the revision of this document to make sure it agrees with the most current revision
found in the FMS Technical Library. Download the latest revision if necessary.

IMPORTANT: All references to other manuals and instructions in this manual can be found in
the FMS Technical Library. Make sure you have the most recent revision.

READ CAREFULLY: OPW Fuel Management Systems and Dover Fueling Solutions cannot
be held responsible for installations, configurations or use of its products that does not comply
with the most recent documentation available.

NOTE: It will be necessary to have Single Sign-On (SSO) credentials to get access to
manuals, instructions, software updates and other important assets. Speak with your FMS
sales representative or contact FMS Customer Service at 1-888-679-3835 (1-888-OPW-
FUEL) for information. Once you have been approved for SSO credentials go to the FMS
Technical Library to find the most recent revisions of all manuals and instructions.

https://www.doverfuelingsolutions.com/

© 2022 Dover Fueling Solutions. All Rights Reserved. DOVER, the Dover D Design, DOVER FUELING
SOLUTIONS, and other trademarks referenced herein are trademarks of Delaware Capital Formation,
Inc./Dover Corporation, Dover Fueling Solutions U.K., Ltd. and their affiliated entities. 02122019v01

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 2

https://dover.sharepoint.com/sites/DFS-SSO/KB/FMS Technical Library/Forms/Products.aspx
https://dover.sharepoint.com/sites/DFS-SSO/KB/FMS Technical Library/Forms/Products.aspx
https://www.doverfuelingsolutions.com/


Table of Contents

Section 1 Introduction 9

1.1 Dashboard 9

1.2 Site Dashboard 10

1.2.1 Dashboard Pump Icon Table 12

1.3 Fuel Island Terminal (FIT) Icon Table 13

1.4 User Interface 13

1.4.1 Screen Views 13

1.4.1.1 Table View 13

1.4.1.2 Add/Edit View 15

1.4.2 Export Button 17

1.4.3 Customer Release Notification 17

1.4.4 Session Expire Warning 18

Section 2 Notifications 19

2.1 Contacts 19

2.2 Create Contact Group 22

2.3 Alerts 24

2.4 Alert History 26

Section 3 Cards Menu 27

3.1 PCF Defaults 28

3.1.1 Account Defaults 28

3.1.1.1 Account Information 28

3.1.1.2 Extended Prompts Tab 29

3.1.2 Driver Defaults 30

3.1.2.1 Driver Details 30

3.1.2.2 Extended Prompts Tab 32

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 3



3.1.3 Vehicle Defaults 32

3.1.3.1 Vehicle Details 32

3.1.3.2 Extended Prompts Tab 34

3.2 Accounts 35

3.2.1 Create Account 36

3.2.1.1 Account Information Tab 36

3.2.1.2 Extended Prompts Tab 37

3.2.2 Manage Column 38

3.2.3 Card Management 39

3.3 Driver/Vehicle Records 40

3.3.1 Card Information Tab 42

3.3.1.1 Extended Prompts Tab 44

3.3.1.2 Maintenance Tab 45

3.4 Card Import 46

Section 4 Transactions 47

4.1 My Transactions 47

4.2 Export Data 50

4.3 Custom Export 52

4.4 Export TRN File 54

4.5 Reprice 55

4.6 TRN Download 56

Section 5 Reports Menu 57

5.1 Reports 57

5.2 Scheduler 60

5.3 Downloads 61

5.4 Power BI Reports 62

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 4



5.5 Power BI Report Descriptions 62

5.6 Leading Zeros in Delimited Reports 68

5.6.1 Newer Versions of Excel (June 2017 version 1704 and later) 69

5.6.2 Use the Text Import Wizard (older versions of Excel [2010-2016]) 71

Section 6 Settings Menu 75

6.1 Sync 76

6.1.1 System Time Settings 76

6.1.2 Action Panel 78

6.1.2.1 Read 78

6.1.2.2 Send 78

6.1.2.3 Upgrade FSC3000 Firmware 79

6.1.2.4 Reset the FSC3000 79

6.1.2.5 Open/Close System 80

6.1.2.6 Initialize Peripherals 80

6.1.2.7 System Start 80

6.1.2.8 Change Password 81

6.2 Job Status 82

6.3 Sites 84

6.3.1 Manage Icons 84

6.3.2 Edit:Site and Controller 85

6.3.2.1 Site Details 85

6.3.2.2 Edit Controller Information 86

6.3.2.3 FSC COM Port Settings 88

6.3.2.4 ATG Settings 88

6.3.3 Tank and Pumps 89

6.3.3.1 Tank 89

6.3.3.2 Pump Controller 90

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 5



6.3.3.3 Pump 93

6.3.4 Terminals 95

6.3.4.1 Terminals 95

6.3.4.2 Message 97

6.3.4.3 Prompts 98

6.3.4.4 Receipt 99

6.3.5 Networks 99

6.3.5.1 Added Networks 99

6.3.5.2 Add/Edit Network 99

6.4 Network Configuration 108

6.4.1 Atio.net 109

6.4.2 Buypass 111

6.4.3 CFN 113

6.4.4 COMDATA and Comdata POS 116

6.4.5 Company Card 118

6.4.6 EFS 120

6.4.7 Federated Co-op 122

6.4.8 FleetOne 124

6.4.9 Intevacon 126

6.4.10 Irving Oil 128

6.4.11 Kardtech 130

6.4.12 NBS BANK 132

6.4.13 NBS/FMGC (Fuelman/Gascard) 134

6.4.14 OPW Generic 136

6.4.15 Paymentech 138

6.4.16 Quarels 140

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 6



6.4.17 Quick Fuel 143

6.4.18 QUIKQ 145

6.4.19 Shell Canada 147

6.4.20 TCH 149

6.4.21 T-CHEK 151

6.5 System Configuration 153

6.5.1 Products 153

6.5.1.1 Unit 153

6.5.1.2 Type 154

6.5.2 Restrictions 155

6.5.2.1 Product Restriction 155

6.5.2.2 Quantity Restriction 156

6.5.3 Odometer Reasonability 157

6.5.4 Define Card Record 157

6.5.5 Tiered Pricing 162

6.5.6 Define Transaction Records 164

6.5.6.1 Options 164

6.5.6.2 Display Fields 165

6.5.6.3 Computer Format 165

6.5.7 Receipt Body 165

6.5.8 User String 166

6.5.8.1 Create User Field Labels 167

6.5.8.2 Create Proprietary Prompts. 168

6.5.9 Cards 168

6.5.9.1 Card Status 168

6.5.9.2 Card Types 169

6.5.10 ATG (Automatic Tank Gauge) Configuration 170

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 7



6.6 Pricing 171

6.7 Fuel Zones 172

6.8 Terminal Window 174

6.8.1 FSC Commands History 174

6.9 Audit Log 177

Section 7 Support Menu 179

7.1 Onboarding 180

7.2 Mobile Support 181

7.3 Sync Transaction 182

7.4 Support View 183

7.5 Demo Suite 184

7.6 Notification Management 185

Section 8 Help 187

8.1 Contact Us 187

8.2 Training Videos 187

Appendix A - AVI: Automatic Vehicle Identification 188

Appendix B - DX Fleet Glossary 191

Appendix C - Version Release Notes 196

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 8



Section 1 Introduction

IMPORTANT: This manual reflects the layout of the menu structure from left to right.
However, you must configure parameters in the menu items under "Settings" before you can
proceed to use the other menu drop-downs.

DEPENDENCY: You will see this DEPENDENCY panel wherever there is a feature or
functionality in one screen or menu item that requires an action in another screen or menu
item to activate that feature or functionality. A cross-reference between the two is used for
easy reference.

1.1 Dashboard
When you log in to DX Fleet, the Network Dashboard comes up as the Home Screen. The Network
Dashboard gives the user an-at-a-glance view of important transaction information.

The image above shows the different parts you will find on the Dashboard.

The Main Menu (blue bar) at the top of the screen will show on all screens in the application.
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1. Click the Dashboard link on the Menu Bar to return to the Dashboard from another screen in the
application.

2. There are six (6) Drop-down Menus in the Main Menu Bar where data for Networks and Sites can be
configured.

a. "Notifications" on page 19 is where Contacts and Contact Groups can be configured

b. "Cards Menu" on page 27 is where you will set up your Account, Driver and Vehicle records.

c. "Transactions" on page 47is where you can define transaction details and set up data and file
exports.

d. "Reports Menu" on page 57 contains selections to configure, schedule and download up to 21
pre-defined reports and up to 51 different Power BI reports.

e. The "Settings Menu" on page 75 is used to configure site and system parameters. Selections in
the sub-menus can affect the information shown on other screens. Therefore, it is
recommended to set up the parameters in the sub-menus under Settings before you proceed
to the other menus.

f. The "Support Menu" on page 179 is only available on technician versions of this application and
is used for onboarding and troubleshooting.

3. The Help selection will take you to a page where you can get access to help tools.

4. Use the Active Org(organization) drop-down to select the organization to be configured. An Active
Org must be selected so that sites in the Site Selection drop-down (in #8 below) are populated.

5. Use the Language drop-down to select from English, Spanish or French.

6. This icon in the Main Menu bar shows the current logged-in User.

7. The "Bell" icon in the Main Menu bar shows Alert Notifications for the logged-in user (see "Alerts" on
page 24). The number of Alerts will show and the drop-down will show links to the Alerts in the system.

8. Select a Site from the Site Selection drop-down to see at-a-glance information in the Dashboard for
the selected site. Select All from the drop-down to show a composite of all sites in your Network. See
the next section below for information on Site Dashboards.

REMINDER: An Active Org must be selected so that this drop-down can be populated (see #4
above).

9. Select a Date Range from the Date Selector to show the necessary data to be shown on the display.

10. Each of the Dashboard Graphs can be modified to show the type of data (Sales in dollars or Volume
in gallons) or change the graph type (as a bar graph or line graph). The selected types show in blue.

11. Hover your mouse pointer over a data point on a graph to see the value of that data point.

12. If there are Active Alerts in the system they will show in the bottom panel of the display.

13. You can export the Active Alerts shown on the dashboard as either an Excel or CSV file (See "Export
Button" on page 17).

1.2 Site Dashboard
The Site Dashboards show more information about the individual site in the top panel.
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1. Select a site from the Site Selection drop-down. The page will refresh to show data applicable to the
selected site.

2. Click the Calendar icon to select a Date Range to show the necessary data to be shown on the
display.

3. The Site Status and Transaction Buffer status is shown in the top right of the panel

4. The Pump Status area shows the condition of pumps at the site. See the table below for more
information on the color-coded icons for pumps.

5. The FIT (see "Fuel Island Terminal" on page 192) Status area shows the condition of FITs installed at
the site. See the table below for more information on the color-coded icons for FITs.
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1.2.1 Dashboard Pump Icon Table

Icon Color Status Description

Green
(Up) Ready The pump is online and ready to authorize.

Yellow
(Up) Calling The pump is online. The pump handle is lifted on a non-

authorized pump.

Green
(Down) Authorized The pump is online and authorized.

Green
(w/drop) Dispensing The pump is online, authorized and dispensing fuel.

Yellow
(Down) Stopped The pump is online but in a stopped condition (because

of a time-out or maximum limit).

Red Sentry The pump is online but shut down by the Pump Sentry.

Red Down The pump is offline.

Gray Offline/Stopped Edge offline, FSC offline, Service Engine stopped
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1.3 Fuel Island Terminal (FIT) Icon Table
Icon Color Status Description

Blue Normal/Ready The terminal is online, ready to use with no errors.

Yellow Paper Low The terminal is online. Te receipt printer paper is low
(where applicable).

Red
Paper Out
Paper Jam
Offline

The terminal is online. The receipt printer is out of
paper (where applicable).

The terminal is online. A receipt printer paper jam has
been detected (where applicable).

There is no communication with the terminal.

Gray Offline/Stopped Edge offline, FSC (see "Fuel Site Controller" on page 192)
offline, Service Engine stopped

1.4 User Interface
1.4.1 Screen Views
There are two (2) basic types of screens that the user will see. A Table View is an information-only screen
that shows configured information in a table format. An Edit View is a screen with editable fields, drop-down
selections and other controls that can be used to configure and edit the parameters on that screen.

1.4.1.1 Table View

Table View: A Table View shows a summary of each configured record's information. These screens can
also show applicable action buttons (see Screen Buttons below) for edits or to make a new record.
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1. Main Menu Bar

2. Menu Path

3. Information Columns

4. Manage Icons: Applicable action icons for record rows will come into view when a row is selected or
upon mouse hover. See below for more information on Manage icons.

5. Add Button: When this icon is available you can select the icon to go to a page to set up parameters for
a new record.

NOTE: Add pages are the same as Edit pages however, there can be fields in some Edit
pages that, once selected in its Add page, cannot be edited. This is typically because of a
dependent parameter set up in another screen.

6. Search Field: The search field can be used to find information in the table based on information you
know. As you type, the application will automatically begin to filter the results directly in the table.

Screen Buttons
The Table View screens can show different icons under the Manage column. Each icon has a "tool tip" that
comes up when a mouse pointer hovers over that icon to explain what the icon is for. The most common
icons are shown below.

l Edit: Click the pencil icon to go to the edit screen for the selected record when this icon is available.
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NOTE: Edit pages are the same as Add pages however, there can be fields in some Edit
pages that, once selected in its Add page, cannot be edited. This is typically because of a
dependent parameter set up in another screen.

l Delete: Click the trash can icon to delete the selected record when this icon is available.

l Validate/Invalidate: Click the forward/back arrow icon to validate or invalidate an account. A
warning pop-up will show important messages. This icon shows on the Cards > Accounts and
Cards > Dr iver /Vehic le Records pages.

l Latest Transaction/Record: Click the calendar icon to see the most recent record. This icon
shows on the Cards > Accounts and Cards > Dr iver /Vehic le Records pages.

l Show All Cards: Click the Card icon to see all cards in an account. This icon shows on the Cards
> Accounts page.

l Download: Click the download icon to download a file to your computer or device when this icon is
available.

l View: Click this icon to see the complete recordwhen this icon is available.

l Login/Onboard: Click this icon to go to prompts to log in to a device or onboard a site (onboarding
is only available to technicians).

l Resend Cards: Use this icon to resend cards to the FSC3000. This icon is available on the
Set t ings > Si tes page.

l Start/Stop: This icon is used to start and stop the Service Engine for a selected site. A warning will
pop up to ask if you want to stop the service engine. This icon is available on the Set t ings >
Si tes page

l Restart Edge: Under Set t ings > Si tes, use this icon to restart the Edge device. See "Manage
Icons" on page 84.

l Save: When you are in the Edit Mode (after the edit icon has been selected under "Manage") in the
Set t ings > Si tes > Display Messages or the Set t ings > Si tes > Display
Promptsscreen, you can click this Save icon to save a custom message or prompt.

l Cancel: When you are in the Edit Mode (after the edit icon has been selected under "Manage") in
the Set t ings > Si tes > Display Messages or the Set t ings > Si tes > Display
Promptsscreen, you can click this Cancelicon to the original screen.

1.4.1.2 Add/Edit View
An Add/Edit View is used to enter new information to an existing record or to edit a current record. The image
below shows the controls that you will most often see when you are in a screen's edit mode.

To enter an Add view, click the Add ( ) icon at the top right of a Table View screen where applicable.

To enter an Add view, click the Edit ( ) icon in the Manage column of a record row in a Table View.
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Edit View: Information is entered in fields and controls that include:

1. Text entry fields: Type information directly into these fields.

2. Drop-downs: Select an option from a drop-down field.

3. Slider buttons: These controls are used to activate an option.

4. Radio buttons: You can select a single option from a group of options.

5. check boxes: You can select multiple options from a group of options.

6. Date Range Selector: These controls let you select a date or date range

Required fields: Fields in red are required. You cannot save a record that has a blank required field.

Fields not available: Some fields are not available and are shown in gray and the cursor will change to a red
circle and slash. These fields require a selection or action from another field or control. Alternatively, a field
that is not available will not show a cursor when clicked. These fields are usually default values that cannot
be changed.

NOTE: Edit View screens have a save button that let you save changes to your configuration.
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1.4.2 Export Button

Select screens will have an Export button in the upper right of the screen near the search field. This has
been added as a quick way to export data from those screens.

1. Click the Export button.

2. Select a File Type from the drop-down.

3. Click Export. A confirmation message will pop up to show that the exported file is ready for download.

4. Go to Repor ts > Downloads.

5. Select the Export File tab.

6. Look for the file you just requested.

7. Click the Download icon in the Manage column on the far right of the selected file. The file will be
downloaded to your device.

The Export Button shows on the screens in the table below:

Dashboard Notifications Cards Transactions Settings

Active Alerts Panel Contacts Accounts Transactions Job Status

Contact Groups Driver/Vehicle Records Export Data Sites

Alert History Fuel Zones

Audit Log

1.4.3 Customer Release Notification
When you log in to DX Fleet after a new release has been published, a message will come up that shows the
latest updates to the application. You have two option buttons:

l Read Later: This will close this window but you can click the Notifications icon in the upper right of the
Home screen to open the Release Notifications again.

l Click Acknowledge after you have reviewed the update list to close the window.

TIP: At the end of this manual you will find a listing of "Version Release Notes" on page 196.
You will find the features that were updated for each release with internal cross-references
that take you to the applicable section in this manual.
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1.4.4 Session Expire Warning
When the application has been idle for 29 minutes a "Session Expire Warning" will pop up with a 60-second
count-down timer. When the timer reaches 0 (zero), the session will time-out and the user will be logged out
automatically. The message will ask, "...do you want to extend the session?" Select OK to extend or Logout
to log out of the application immediately.
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Section 2 Notifications

IMPORTANT: You must first set up parameters for your sites in the Settings menu before you
can add Contacts and Groups.

The Notifications menu is where you set up:

l Contacts (see below)

l Contact Groups (refer to"Create Contact Group" on page 22)

l Alerts (refer to "Alerts" on page 24).

l Alert History (refer to "Alert History" on page 26).

2.1 Contacts
[Not i f i ca t ions > Contac ts ]

The table view shows contacts that have been configured.

Click the Add ( ) button next to the search bar to enter a New Contact.

To edit a Contact, select the Edit ( ) icon in the far-right column of the applicable Contact Name to edit the
Contact's edit screen will come into view.

Add/Edit information in the Contacts fields.
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NOTE: Fields shown in Red below are required.

1. Name: Enter a Name (up to 50 alphanumeric or special characters).

2. Company: Enter the Company Name.

3. Email: Enter the User's email (up to 75 alphanumeric or special characters).

4. Phone: Enter the User's phone. Use up to 11 numeric characters or the US format X-XXX-XXX-XXXX.
This field is required if the Accepts Text Messages slider (below) has been selected.

DEPENDENCY: To be set up to receive text messages in "Create Contact Group" on page 22,
this phone must be able to receive SMS (Short Message Service, frequently referred to as a
text message) messages.

5. Accepts Text Messages: Use this slider button to show that this user can accept SMS messages.

6. Language: Select from the drop-down (where applicable).

7. Click the Save button.

To Edit a record, click the pencil icon to go to the edit screen for the selected record. You can edit the same
fields as above.
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To Delete a record, click the trashcan icon to delete the selected record.

You can export the list of Contacts shown on the page as either an Excel or CSV file.

l Click the Export button in the upper-right of the "Contacts" panel. A dialogue box will open.

l Select a File Type from the drop-down.

l Click the Export button. A confirmation notice will come up to tell you when the exported file is
ready for download.

l Go to the Reports tab and select Downloads from the drop-down.

l Select the "Export File" tab.

l Find the file to be downloaded (use the "Export Item" and "Created Date" columns to find the
applicable file).

l Click the ( ) Download icon to download the file to your computer or device.
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2.2 Create Contact Group
[Not i f i ca t ions > Contac t Groups]

Contact Groups can be set up from the list of available Contacts. These groups are useful if it is necessary
to send a message or alert to all of the contacts of a selected group at one time.

The table view of the Contact groups screen shows Contact Groups that have been configured. Information
shown is the Group Name and Entries (Contact email addresses).

To edit a Contact Group, select the Edit ( ) icon under the Manage column.

To Add a new Contact Group, lick the Add ( ) icon in the top right of the screen.

The Add/Edit Contact Group screen will come into view.

l Always send text messages to this group: Use this slider button to show that this group can accept
SMS messages.

DEPENDENCY: Messages can only be sent to contacts with a cell phone that can accept
SMS text messages. This phone number must be set up in "Contacts" on page 19.

l Enter a Group Name (up to 30 alpha characters). This name will be used in Alerts and any other drop-
downs where a Contact Group is available for selection.

l Select entries from the Available Contacts list box.

TIP: To select multiple contacts, hold the Control (Ctrl) key as you click each applicable
contact in the list.

l Click Add to move the selected names over to the Selected Contacts list box.

l Click the Save Contact Group button.

If it is necessary to make changes to a full record for a Contact Group:
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l To add entries from the Available Contacts list box:

n Select entries from the Available Contacts list box.

n Click Add to move the selected names over to the Selected Contacts list box.

l To remove entries from the Selected Contacts list box:

n Select entries from the Selected Contacts list box.

n Click Remove to move the selected names over to the Available Contacts list box.

Click the Save button.

You can export the list of Contact Groups shown on the page as either an Excel or CSV file.

DEPENDENCY: Contact Groups must be set up in this screen before they show as available
selections in the "Contact Group" column drop-downs in "Alerts" on the next page.

l Click the Export button in the upper-right of the "Contact Groups" panel. A dialogue box will open.

l Select a File Type from the drop-down.

l Click the Export button. A confirmation button will come up to tell you when the exported file is
ready for download.

l Go to the Reports tab and select Downloads from the drop-down.

l Select the Export File tab.

l Find the file to be downloaded (use the "Export Item" and "Created Date" columns to find the
applicable file).

l Click the ( ) Download icon to download the file to your computer or device.
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2.3 Alerts
[Not i f i ca t ions > Aler ts ]

The Alerts screen can be edited to set up specified Alert types, the Contact Group that is to receive the Alert
(s) and the communication method (email and/or text message).

l Select an Active Site from the drop-down at the top of the screen.

l Select the slider button for each applicable Alert.

l Select a Contact Group from the drop-down where the Alert will be sent.

DEPENDENCY: Contact Groups must be set up in "Create Contact Group" on page 22 before
they show as available selections in this drop-down.

l Select the slider button(s) to specify the communication method (Email and/or Text Message).

l Email/SMS Notify After: Select the applicable time (in 5 minute increments) from the drop-down list
from Immediate to 30 minutes in five (5) minute increments (see "Short Message Service, frequently
referred to as a text message" on page 194).

l When all applicable Alerts have been entered, click the Save Changes button to update the Alerts for
the selected Active Site.

Below is a list of the available alerts:

Receipt Paper Low: The receipt paper sensor of the terminal has detected a low paper condition.

Receipt Paper Out: The receipt paper sensor of the terminal has detected a paper out condition.

Receipt Paper Jam: There is a paper jam in the receipt printer. Printer is down.

FIT Down: There is no communication with the terminal.

Pump Offline: There is no communication with a pump.
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Pump Sentry Activated: This option stops the pump if three zero quantity transactions occur in a row. This
could mean possible pump or pulser trouble.

Edge Device Offline: There is no communication with the Edge device.

FSC Offline: There is no communication with the FSC3000.

Transaction Buffer Near Full: The number of stored transactions has reached approximately 90%
capacity.

Transaction Buffer Full, Site Down!: Stored transactions have reached capacity.

See "Alert History" on the next page under Notifications (Not i f i ca t ions > Aler t H is tory ).
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2.4 Alert History
[Not i f i ca t ions > Aler t H is tory ]

This screen shows the status of Alerts.

NOTE: Alerts are sorted in descending chronological order from the most recent "Created
Date" by default.

Select an Active Site from the drop-down at the top of the screen.

The Alert History for the selected site will show:

l The Alert Name (short description of the Alert)

l The applicable Device Type (FSC, Edge Device, FIT, Pump etc.)

l The applicable Device Number

l The date the Alert was created

l The current status of the Alert

l The date the Alert was cleared (if applicable)

You can export the Alert History list shown on the page as either an Excel or CSV file.

l Click the Export button in the upper-right of the "Active Alerts" panel. A dialogue box will open.

l Select a File Type from the drop-down.

l Select a Date Range from the Date Selector.

l Click the Export button. A confirmation notice will come up to tell you when the exported file is
ready for download.

l Go to the Reports tab and select Downloads from the drop-down.

l Select the Export File tab.

l Find the file to be downloaded (use the "Export Item" and "Created Date" columns to find the
applicable file).

l Click the ( ) download icon to download the file to your computer or device.
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Section 3 Cards Menu
This menu has the selections necessary to set up the card settings for sites. The topics in this section will
include:

l "PCF Defaults" on page 1

n "Account Defaults" on page 1

n "Driver Defaults" on page 1

n "Vehicle Defaults" on page 1

l "Accounts" on page 1

l "Driver/Vehicle Records" on page 1

l "Card Import" on page 46
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3.1 PCF Defaults
Cards> PCF Defau l ts

In this menu selection you can set up the PCF (see "Proprietary Card File" on page 193) default settings for
Account, Driver and Vehicle cards.

3.1.1 Account Defaults
[Cards > PCF Defau l ts > Account Defau l t Set t ings ]

The Account Defaults page has two (2) tabs:

l Account Information tab: Specify applicable Account related information.

l Extended Prompts tab: Specify applicable Extended Prompts related to the Account.

3.1.1.1 Account Information

l Product Restriction: This option lets you limit the fuel type(s) dispensed for each transaction. Select
from the drop-down.

DEPENDENCY: The selections are specified in "Product Restriction" on page 155
(Sett ings > System Configuration > Restrict ions > Product
Restr ict ion) setup screen.

l Quantity Restriction: This option lets you limit the quantity dispensed for each transaction. Select
from the drop-down.
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DEPENDENCY: The selections are specified in "Quantity Restriction" on page 156
(Sett ings > System Configuration > Restrict ions > Quantity

Restr ict ion) setup screen.

l Daily Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a card
in a single 24-hour period, from midnight to 11:59 p.m.

l Monthly Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a
card each month, from midnight of the first day of the month to 11:59 p.m. on the last day of the month.

DEPENDENCY: Allocation options are only available when selected in Settings >
Edit System Configuration > Define Card Record. See "Define Card Record" on
page 157for more information.

l Expiration Date: This option lets you select a date when the card will expire and no longer be
operational within the Fuel Site Controller. Use the slider button to enable this option. Select an
Expiration Date from the Date Selector.

Click the Save button to save this configuration.

3.1.1.2 Extended Prompts Tab

DEPENDENCY: The Extended Prompts tab is only available when Prompt Sequence is
selected under Sett ings > Edi t System Conf igurat ion > Def ine Card Record. See
"Define Card Record" on page 157.
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The extended prompts tab on each of the Accounts, Driver and Vehicle pages lets the user configure up to 8
prompts for entry against all driver and vehicle records related to the account.

Use the slider button to select up to eight (8) prompts in the Prompt For column.

Three (3) of the eight (8) selected prompts can be configured for prompt verification. When the Verified slider
button is enabled, the user MUST enter a verified entry value that the FSC3000 can then confirm.

Prompt Order: Select from the drop-down to configure the prompt order.

Click the Save button to save this configuration.

3.1.2 Driver Defaults
The Driver Defaults page has two (2) tabs:

l Driver Information tab: Specify applicable Driver related information.

l Extended Prompts tab: Specify applicable Extended Prompts related to the Driver.

3.1.2.1 Driver Details

l Account configured controls will be used to manage this record: When this slider button is
enabled, all field labels shown below with a red asterisk (*) will be turned off. The related Account
based controls will be used as an alternative.

l Driver Number: Enter up to 24 alphanumeric characters. This is used as a record in transaction
reports.

l Record Status: Select from the drop-down. a Record Status of Valid shows that this record can get
fuel. All other values in the drop-down will set a record to Invalid.

l Presented Media 1: A value related to a Driver/Vehicle Record used to authorize a transaction. Enter
up to 19 alphanumeric characters.

l Presented Media 2: A secondary value related to a Driver/Vehicle Record used to authorize a
transaction. Enter up to 19 alphanumeric characters.
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DEPENDENCY: A second Presented media is only be available when "Use two
different media devices for driver/vehicle record authorization" is selected in
Settings > Edit System Configuration > Define Card Record. See "Define Card
Record" on page 157for more information.

l *Quantity Restriction: This option lets you limit the quantity dispensed for each transaction. Select
from the drop-down.

DEPENDENCY: The selections are specified in "Quantity Restriction" on page 156
(Sett ings > System Configuration > Restrict ions > Quantity

Restr ict ion) setup screen.

l *Product Restriction: This option lets you limit the fuel type(s) dispensed for each transaction. Select
from the drop-down.

DEPENDENCY: The selections are specified in "Product Restriction" on page 155
(Sett ings > System Configuration > Restrict ions > Product
Restr ict ion) setup screen.

l *Monthly Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a
card each month, from midnight of the first day of the month to 11:59 p.m. on the last day of the month.

l *Daily Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a card
in a single 24-hour period, from midnight to 11:59 p.m.

DEPENDENCY: Allocation options are only available when selected in Settings >
Edit System Configuration > Define Card record. See "Define Card Record" on
page 157for more information.

l *Expiration Date: This option lets you select a date when the card will expire and no longer be
operational within the Fuel Site Controller. Use the slider button to turn this option on. Select an
Expiration Date from the Date Selector.

Fuel Zone: Select from the drop-down. This setting tells DX Fleet the sites this record can get fuel from.
When a card update is flagged for this record it will be sent/updated to all sites with the assigned fuel zone.

DEPENDENCY: For the Fuel Zone to be populated, Fuel Zones must be configured under
Settings > Fuel Zones (see"Fuel Zones" on page 172).
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Select one or more of the slider buttons for:

l Card Operates as Single Entry

DEPENDENCY: This control is only available when "Allow use of Single Entry under Dual
Entry" is enabled under Sett ings > Edi t System Conf igurat ion > Def ine Card
Record. See "Define Card Record" on page 157

l Prompt for Misc Entry: tells the Fuel Site Controller to prompt for a miscellaneous keyboard entry. FIT
display message #29 will appear at the Fuel Island when the Card is swiped with this switch setting.

l Prompt for Odometer Entry

Click the Save button to save this configuration.

3.1.2.2 Extended Prompts Tab

DEPENDENCY: The Extended Prompts tab is only available when Prompt Sequence is
selected under Sett ings > Edi t System Conf igurat ion > Def ine Card Record. See
"Define Card Record" on page 157.

The extended prompts tab on each of the Accounts, Driver and Vehicle pages lets the user configure up to 8
prompts for entry against all driver and vehicle records related to the account.

Use the slider button to select up to eight (8) prompts in the Prompt For column.

Three (3) of the eight (8) selected prompts can be configured for prompt verification. When the Verified slider
button is enabled, the user MUST enter a verified entry value that the FSC3000 can then confirm.

Prompt Order: Select from the drop-down to configure the prompt order.

Click the Save button to save this configuration.

3.1.3 Vehicle Defaults
The Vehicle Defaults page has two (2) tabs:

l Vehicle Information tab: Specify applicable Vehicle related information.

l Extended Prompts tab: Specify applicable Extended Prompts related to the Account.

3.1.3.1 Vehicle Details
l Account configured controls will be used to manage this record: When this slider button is

enabled, all field labels shown below with a red asterisk (*) will be turned off. The related Account
based controls will be used as an alternative.

l Vehicle Number: Enter up to 24 alphanumeric characters. This is used as a record in transaction
reports.

l Record Status: Select from the drop-down. a Record Status of Valid shows that this record can get
fuel. All other values in the drop-down will set a record to Invalid.
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l FSC Presented Media 1: A value related to a Driver/Vehicle Record used to authorize a transaction.
Enter up to 19 alphanumeric characters.

l Presented Media 2: A secondary value related to a Driver/Vehicle Record used to authorize a
transaction. Enter up to 19 alphanumeric characters.

DEPENDENCY: A second Presented media is only be available when "Use two
different media devices for driver/vehicle record authorization" is selected in
Settings > Edit System Configuration > Define Card record. See "Define Card
Record" on page 157for more information.

l *Quantity Restriction: This option lets you limit the quantity dispensed for each transaction. Select
from the drop-down.

DEPENDENCY: The selections are specified in "Quantity Restriction" on page 156
(Sett ings > System Configuration > Restrict ions > Quantity

Restr ict ion) setup screen.

l *Product Restriction: This option lets you limit the fuel type(s) dispensed for each transaction. Select
from the drop-down.

DEPENDENCY: The selections are specified in "Product Restriction" on page 155
(Sett ings > System Configuration > Restrict ions > Product
Restr ict ion) setup screen.

l *Monthly Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a
card each month, from midnight of the first day of the month to 11:59 p.m. on the last day of the month.

l *Daily Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a card
in a single 24-hour period, from midnight to 11:59 p.m.

DEPENDENCY: Allocation options are only available when selected in Settings >
Edit System Configuration > Define Card record. See "Define Card Record" on
page 157for more information.

l *Expiration Date: This option lets you select a date when the card will expire and no longer be
operational within the Fuel Site Controller. Use the slider button to turn this option on. Select an
Expiration Date from the Date Selector.

Fuel Zone: Select from the drop-down. This setting tells DX Fleet the sites this record can get fuel from.
When a card update is flagged for this record it will be sent/updated to all sites with the assigned fuel zone.
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DEPENDENCY: For the Fuel Zone to be populated, Fuel Zones must be configured under
Settings > Fuel Zones (see"Fuel Zones" on page 172).

Select one or more of the slider buttons for:

l Card Operates as Single Entry

DEPENDENCY: This control is only available when "Allow use of Single Entry under Dual
Entry" is enabled under Sett ings > Edi t System Conf igurat ion > Def ine Card
Record. See "Define Card Record" on page 157

l Prompt for Misc Entry

l Prompt for Odometer Entry

Click the Save button to save this configuration.

3.1.3.2 Extended Prompts Tab

DEPENDENCY: The Extended Prompts tab is only available when Prompt Sequence is
selected under Sett ings > Edi t System Conf igurat ion > Def ine Card Record. See
"Define Card Record" on page 157.

The extended prompts tab on each of the Accounts, Driver and Vehicle pages lets the user configure up to 8
prompts for entry against all driver and vehicle records related to the account.

Use the slider button to select up to eight (8) prompts in the Prompt For column.

Three (3) of the eight (8) selected prompts can be configured for prompt verification. When the Verified slider
button is enabled, the user MUST enter a verified entry value that the FSC3000 can then confirm.

Prompt Order: Select from the drop-down to configure the prompt order.

Click the Save button to save this configuration.
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3.2 Accounts
[Cards > Accounts ]

This Table View shows a summary of configured Accounts and related Cards.

To set up a new Account:
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Click the Add ( ) button. The "Create Account" screen will come into view.

3.2.1 Create Account
l Account Status: Select the applicable radio button (Valid, Invalid). If set to Invalid, all cards below this

card are not permitted to fuel. An error of "Account Invalidated" will show.

l The Expiration Date controls are used to activate and configure the expiration date sent to the
FSC3000. when it is configured here, all new accounts will be set with this entry as their current value.

To set an Expiration Date:

n Set the Expiration Date slider to the On position.

n Select a date from the Date Selector field.

The Create Account screen has two (2) tabs:

l Account Information tab: Specify applicable Account related information.

l Extended Prompts tab: Specify applicable Extended Prompts related to the Account.

3.2.1.1 Account Information Tab
Account Details

l Account ID: Enter from 3-50 alphanumeric or special characters (the minimum is 3 characters).

l Account Name: Enter the name of the Account or the Merchant customer that will use PCF (see
"Proprietary Card File" on page 193) management. This field will accept up to 50 alphanumeric or
special characters.

l Account User 1: Enter the applicable name in this field. The field will accept up to 30 alphabetic
characters as well as, '-' (en dash) and ',' (comma).

l Account User 2: Enter the applicable name in this field. The field will accept up to 30 alphabetic
characters as well as, '-' (en dash) and ',' (comma).

l Address: Enter the Account address.

l City: Enter the applicable city in this field. The field will accept up to 30 alphabetic characters as well
as, '-' (en dash) and ',' (comma).

l State: Enter the State.

l Zip/Postal Code: Enter the applicable code. The field will accept up to 10 alphanumeric characters as
well as, '-' (en dash).

l Contact Name: Enter the applicable name in this field. The field will accept up to 30 alphabetic
characters as well as, '-' (en dash) and ',' (comma).

l Contact Email: Enter up to 50 alphanumeric or special characters.

l Contact Phone: Enter an applicable phone number. The field will accept up to 18 numeric characters
as well as "+" (plus sign) and '-' (en dash/minus sign).

l Accepts Text Messages: Enable this slider button if text messages can be sent to the Mobile/Cell
phone number above.

Account controls

l FSC Account #: Enter the FSC Account number in this field.
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l Short Name: Enter a Short Name for the account (up to nine [9] characters).

Restrictions

l Daily Allocation: Enter an applicable number in gallons.

DEPENDENCY: Allocation options are only available when selected in Settings >
Edit System Configuration > Define Card record. See "Define Card Record" on
page 157for more information.

l Quantity Restriction: This option lets you limit the quantity dispensed for each transaction. Select a
value from the drop-down if applicable.

DEPENDENCY: The selections are specified in "Quantity Restriction" on page 156
(Sett ings > System Configuration > Restrict ions > Quantity

Restr ict ion) setup screen.

l Monthly Allocation: Enter an applicable number in gallons.

DEPENDENCY: Allocation options are only available when selected in Settings >
Edit System Configuration > Define Card record. See "Define Card Record" on
page 157for more information.

l Product Restriction: Select from the drop-down. The selections are specified in the "Product
Restriction" on page 155 (System Conf igurat ion > Rest r ic t ions > Product Rest r ic t ion)
setup screen.

DEPENDENCY: The selections are specified in "Product Restriction" on page 155
(Sett ings > System Configuration > Restrict ions > Product
Restr ict ion) setup screen.

3.2.1.2 Extended Prompts Tab

DEPENDENCY: The Extended Prompts tab is only available when Prompt Sequence is
selected under Sett ings > Edi t System Conf igurat ion > Def ine Card Record. See
"Define Card Record" on page 157.
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The extended prompts tab on each of the Accounts, Driver and Vehicle pages lets the user configure up to 8
prompts for entry against all driver and vehicle records related to the account.

Use the slider button to select up to eight (8) prompts in the Prompt For column.

Three (3) of the eight (8) selected prompts can be configured for prompt verification. When the Verified slider
button is enabled, the user MUST enter a verified entry value that the FSC3000 can then confirm.

Prompt Order: Select from the drop-down to configure the prompt order.

Click the Save button to save this configuration or Cancel to return to the Table View.

3.2.2 Manage Column
The Manage Column contains five (5) buttons for actions that can be done for Accounts.

l Edit the Account. Use the same procedure as above for a new Account.

l Delete the Account.

l Validate/Revalidate Account.

l Latest Transaction. Select this icon to see a table that shows the latest transactions for the
selected Account.

l Show All Cards. Select this icon to see a table that shows all cards for the selected account.
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3.2.3 Card Management

New for Revision 4 is the Card Management feature. This feature lets you Delete or Validate/Re-validate
multiple Account records.

1. The far left column shows check boxes for each record listed. Select all applicable records in this
column for one of the actions.

2. When selections are made in the check box column, icons for Delete and Validate/Re-validate will
come into view in the toolbar to the left of the Add button. Select the correct icon for the applicable
action that will affect all selected Account records.
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3.3 Driver/Vehicle Records
Cards > Dr iver /Veh ic le Records

This Table View shows a summary of configured Driver/Vehicle Records.

To configure a new Record:

Click the Add ( ) button. The Create Driver/Vehicle Record screen will come into view.

1. Select Card Type: Select a radio button to define a Driver or Vehicle record.

2. The Expiration Date controls are used to activate and configure the expiration date sent to the
FSC3000. When it is configured here, all new accounts will be set with this entry as their current value.

To set an Expiration Date:

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 40



n Set the Expiration Date slider to the On position.

n Select a date from the Date Selector field.

DEPENDENCY: The Expiration Date option is only available when selected in
Settings > Edit System Configuration > Define Card Record. See "Define Card
Record" on page 157 for more information.

3. Record Status: Select from the drop-down. a Record Status of Valid shows that this record can get
fuel. All other values in the drop-down will set a record to Invalid.

4. PIN (Security PIN): This numeric field is the PCF (see "Proprietary Card File" on page 193) Personal ID
Number (PIN) (see "Personal Identification Number" on page 193) field. Enter a numeric value up to 23
characters.

DEPENDENCY: The PIN (Security PIN) option is only available when selected in
Settings > Edit System Configuration > Define Card Record. See "Define Card
Record" on page 157 for more information.

5. Allow Misc Entry: This tells the Fuel Site Controller to prompt for a miscellaneous keyboard entry. FIT
display message #29 will appear at the Fuel Island when the Card is swiped with this switch setting.

6. Use Second Language: The FSC3000 can be “bi-lingual” to show or print two different languages. A
Language Type is programmed into all cards. When the card is read, the FIT display language
changes to the programmed language. Some receipts can also be programmed to print out in the
specified language.

7. Card Operates as Single Entry

DEPENDENCY: This control is only available when "Allow use of Single Entry
under Dual Entry" is enabled under Sett ings > Edit System Configuration
> Define Card Record. See "Define Card Record" on page 157

8. Allow Odometer Entry

DEPENDENCY: When this is selected, the Odometer field in the Restrictions
panel (see below) will be available.
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DEPENDENCY: If Odometer Reasonability (see "Resonability" on page 193) has
been turned on under Sett ings > System Configuration > Define Card
Record, (see Odometer Reasonability option "System Configuration" on
page 153) this control will show in the ON position but "grayed-out." (to indicate
that this control is locked). See "Define Card Record" on page 157 for more
information.

NOTE: When this control is active and locked, you must enter the vehicle's
current odometer value in the Odometer field (under Card Information >
Restrict ions below) to enable Odometer Resonability at the Fuel Island
Terminal. To skip the odometer prompt at the terminal, delete the odometer entry
in this field.

The Create Driver/Vehicle Records screen has two (2) tabs:

l Card Information tab: Specify applicable Driver/Vehicle and Account related information.

l Extended Prompts tab: Specify applicable Extended Prompts related to the Account.

3.3.1 Card Information Tab
Driver/Vehicle Details

9. Account configured controls will be used to manage this record: When this slider button is
enabled, all field labels shown below with a red asterisk (*) will be turned off. The related Account
based controls will be used as an alternative.

10. Driver/Vehicle ID: Enter up to 24 alphanumeric characters. This is used as a record in transaction
reports.

11. Driver/Vehicle Name: Enter up to 50 alphanumeric or special characters as a name for the
Driver/Vehicle record above.

12. Card User 1 / 2: Enter alphanumeric or special characters for one or both Card User fields.

13. FSC Presented Media #1 : A value related to a Driver/Vehicle Record used to authorize a
transaction. Enter the applicable numeric characters.

14. FSC Presented Media #2: A value related to a Driver/Vehicle Record used to authorize a
transaction. Enter the applicable numeric characters.

DEPENDENCY: A second Presented media is only be available when "Use two
different media devices for driver/vehicle record authorization" is selected in
Settings > Edit System Configuration > Define Card Record. See "Define Card
Record" on page 157for more information.

Account Controls
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15. Account Selection: Select from the drop-down list of configured Accounts.

16. Short Name: Enter the applicable alphanumeric characters.

Restrictions

17. *Daily Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a
card in a single 24-hour period, from midnight to 11:59 p.m.

18. *Monthly Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a
card each month, from midnight of the first day of the month to 11:59 p.m. on the last day of the month.

DEPENDENCY: Allocation options are only available when selected in Settings >
Edit System Configuration > Define Card record. See "Define Card Record" on
page 157for more information.

19. Odometer: Enter the applicable numeric value.

DEPENDENCY: This field is active only when the Allow Odometer Entry slider
(see above) is selected.

20. *Quantity Restriction: This option lets you limit the quantity dispensed for each transaction. Select
from the drop-down.

DEPENDENCY: The selections are specified in "Quantity Restriction" on page 156
(Sett ings > System Configuration > Restrict ions > Quantity

Restr ict ion) setup screen.

21. *Product Restriction: This option lets you limit the fuel type(s) dispensed for each transaction.
Select from the drop-down.

DEPENDENCY: The selections are specified in "Product Restriction" on page 155
(Sett ings > System Configuration > Restrict ions > Product
Restr ict ion) setup screen.

22. Fuel Zone: Select from the drop-down. This setting tells DX Fleet the sites this record can get fuel
from. When a card update is flagged for this record it will be sent/updated to all sites with the assigned
fuel zone.

Click the Save button to save this configuration.
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3.3.1.1 Extended Prompts Tab

The extended prompts tab on each of the Accounts, Driver and Vehicle pages lets the user configure up to 8
prompts for entry against all driver and vehicle records related to the account.

Use the slider button to select up to eight (8) prompts in the Prompt For column.

Three (3) of the eight (8) selected prompts can be configured for prompt verification. When the Verified slider
button is enabled, the user MUST enter a verified entry value that the FSC3000 can then confirm.

Prompt Order: Select from the drop-down to configure the prompt order.

Click the Save button to save this configuration.
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3.3.1.2 Maintenance Tab

The Maintenance tab can be used to set up a periodic maintenance schedule for five (5) important service
items. For each item you can set a:

l Warning Limit: This is the mileage when each item must be done. Enter an odometer value for the
individual vehicle for each item in the text field.

l No Fuel Limit: This is when the vehicle is overdue for the scheduled item and should be taken in for
service before it can be permitted to get fuel. Enter an odometer value for the individual vehicle for
each item in the text field.

n Invalidate card on No Fuel Limit: To go an extra step to make sure maintenance stays on
schedule, the card used to fuel the vehicle can be invalidated so that the vehicle must be taken
in for service before it can get fuel. Select the check-box for each applicable item.

l Alerts for Warning limits and No Fuel Limits can be set for each maintenance item.

n Select the check-box for the item to send an alert.

n Select the Contact Group to receive the alert(s) from the Alert drop-down at the bottom of the
page.

Select the Update button in the lower right of the screen to save this configuration.
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3.4 Card Import
Cards > Card Impor t

This screen shows instructions on how to import cards into the DX Fleet application.

DEPENDENCY: You must program the items that follow before you continue.

"Accounts" on page 35: Cards Menu > Accounts

"Sites" on page 84: Set t ings Menu > Si tes

"Fuel Zones" on page 172: Set t ings Menu > Fue l Zones

"Tank" on page 89: Set t ings Menu > Si te > Tanks

"Products" on page 153: Set t ings Menu > System Conf igura t ion > Products

"Restrictions" on page 155: Set t ings Menu > System Conf igura t ion > Rest r ic t ions > Product
and Quant i ty Rest r ic t ions > Product Rest r ic t ions tab.

When each of these items is complete you can go back to the Card Import screen and do the steps to import
cards into the DX Fleet application.
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Section 4 Transactions
From this menu, users can look up and see fueling transactions and configure customized export transaction
reports. The topics in this section will include:

l Transactions (see below)

l "Export Data" on page 50

l "Custom Export" on page 52

l "Export TRN File" on page 54

l "Reprice" on page 55

l "TRN Download" on page 56

4.1 My Transactions
Transact ions > My Transact ions

This Table View gives filter options so a user can see a specified transaction history. There are two methods
to use to find applicable information:

l Use the Search box to search for table data based on the available column headers.

l Use the Filter Controls.

n Select a Start and End date from the Select Date Range Date Selectors.

n Select an Account from the Account Selection drop-down.

n Select a Site from the Site Selection drop-down.

n Select a Record Type from the drop-down

n Click the Applybutton.

Click the Add ( ) button to set up the Transaction Details screen parameters.
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TIP: To edit a Transaction, select the Edit ( ) icon in the Manage column of the row of the
Transaction to be edited.

NOTE: Fields shown in Red below are required.

1. Select a Site ID from the drop-down (Site IDs are given during the onboarding process).

2. Give the transaction a number in the Transaction # field (the chronologically numbered transaction for
the fueling site).

3. Select a Transaction Date from the Date Selector.

4. Select a Time from the Time Selector.

5. Enter the applicable information for Sequence # and Termination Code.

n The Sequence # is the day sequence number that is assigned to each transaction. This
number resets daily to track the order in which transactions occurred (were completed) on a
specific day.

n The Termination Code is a letter that indicates how a transaction ended, normally or
abnormally (if abnormally, in what way, i.e. Bad Odometer, Bad Card, User Entry Timeout,
etc.).

INFORMATION: See the termination Codes table in the Transactions Management section of
the M00-051.00 3000 Command-Line Configuration Manual.

6. Select an Account ID from the drop-down. The Account Name will automatically populate.
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NOTE: The Account Name is populated automatically when an Account ID is selected.

7. Select a Driver/Single Record ID from the drop-down.

NOTE: Driver Name and Driver Single Media Presented will automatically populate when a
Driver/Single Record is selected.

8. Select a Vehicle Record ID from the drop-down (if applicable).

NOTE: The Vehicle Name and Vehicle Media Presented will automatically populate when a
Vehicle record ID is selected.

9. Select a Pump # (the pump [dispenser] used during the fueling transaction.) from the drop-down.

10. Select a Hose # (the pump hose that is used during the fueling transaction) from the drop-down.

11. Select the applicable Product ID (The product type that was dispensed during the fueling
transaction).

12. Enter a Misc: Miscellaneous Keyboard is a generic prompt that can be presented during fueling to
collect any numeric entry required. These field labels can be programmed to help identify the value
entered.

13. Odometer Entry: This field reflects a vehicle’s odometer reading entered during the transaction.
Odometer entries are used to calculate the distance traveled between fueling stops.

14. Enter the Price Per Unit: The price charged per gallon of product dispensed during the transaction.

15. Enter the Quantity: The amount of fuel dispensed during the transaction.

16. The Total field will populate automatically. This is the total sales value for a recorded transaction
(calculated as Price Per Unit X Quantity above).

Click the Save button to save this configuration (Edit Transaction when in the edit screen of a configured
transaction) or Cancel to return to the Table View.
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4.2 Export Data
Transact ions > Expor t Data

NOTE: Fields shown in Red below are required.

The Export Data page under "Transactions" will let you export transaction data to a selected file type.

1. Select a Site from the drop-down.

2. Select an Account from the drop-down.

3. Select the applicable option slider buttons:

n Include Network Transactions: This option can be selected when it is necessary for the
exported data to be included with Network-authorized transactions. Under normal export
conditions, only PCF-based transactions (cards managed by DX Fleet) are exported.

n Include Manually Entered Transactions: This option can be selected when it is necessary
for the exported data to include transactions that have been entered manually.

n Exported to Fleet: Select this option to keep transactions from a second export when the
“Never Exported” status is selected (see below). This is an important option when data is
exported that will be imported into a Fleet Maintenance package that cannot filter out duplicate
transaction data.

4. Select a radio button for Standard Export Type or Custom Export Type.

NOTE: If you select Standard Export Type, the Export File Type drop-down (shown below)
will be populated with available file types.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 50



DEPENDENCY: To use the Custom Export Type, you must have a custom export file set up in
the "Create Custom Export" screen. Select the Custom Export option in the Transactions
menu. Refer to "Transactions" on page 47 for more information.

5. Select an Export Status from the drop-down:

n Never Exported: You can only get information for transactions that have not been exported
before.

n Previously Exported: You can only get information for transactions that have been exported
before.

n Both/All: All transactions will be exported.

6. Select an Export File Type from the drop-down. When the Standard Export Type radio button has
been selected, this drop-down shows the available selection of file types in DX Fleet (see above). To
use the Custom Export Type, you must have a custom export file set up in the "Create Custom Export"
screen. Select the Custom Export option in the Transactions menu. Refer to "Transactions" on
page 47 for more information.

7. Select an Export Date Format from the drop-down.

8. Select an Export Time Format from the drop-down.

9. Select a Start Date, Start Time and End Date, End Time from the Date and Time Selectors. If these
are not selected, the current date and time are the defaults.

10. Click the Export button to complete the file export. When the report is complete you will get a "Report
Generated Successfully" message and the report will automatically download to your machine.
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4.3 Custom Export
Transact ions > Custom Expor t

DEPENDENCY: The "Custom Export" Table View will show all customized export files that
can be used to select a Custom Export Type in the "Export Data" screen. See"Export Data" on
page 50.

To set up a new Custom Export Type:

Click the Add ( )button to set up the Custom Export Type parameters.

NOTE: Fields shown in Red below are required.

l Enter a File Name that you want to use as a name for this Custom Export File in the field.

l Select a File Format from the drop-down (XML, Excel, CSV or Text).

l Select from the Available items in the left side panel to populate your file. Use the Select and Sort
buttons shown below to make your Custom Export item list.
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TIP: Hold the CTRL key on your keyboard to select more than one item.

l When you have completed your Custom Export File item list, click Save. Your Custom Export File will
show in the Custom Export Table View. Your file can be selected as a Custom Export Type option in
the Export File Type drop-down of the "Export Data" screen.

TIP: To edit a Custom Export Type in the Table View, select the Edit ( ) icon in the Manage
column of the row of the applicable Custom Export Type to be edited.
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4.4 Export TRN File
You can customize a TRN (Transaction) Export file in this screen.

l Select a Start and End date from the Date Selectors.

l Select a Site from the Site ID drop-down.

l To include Manual Transactions in the export file, put a check the box.

l To include Zero Quantity Transactions in the export file, put a check the box.

l Select all applicable Display Fields to be included in the export file.

l Click the Create button. The system will collect the data. The results will show in the table below the
Display Fields selections.

l Click the Download ( ) icon to download the file.
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4.5 Reprice
The Reprice feature under FSC Transactions allows transactions for the selected accounts and date range
to be "Repriced."

l Click on the Date Range field. There are seven (7) options that can be selected for a date range. If
Custom Range is selected, start and end Date Selectors will come into view where the user can enter
a customized date range.

l You can select the applicable accounts in two ways.

n Enter an Account ID or account Name in the Search field. Suggested results will filter in the
Account List as you type.

n Use the check boxes along the left side of the Account List to select applicable accounts one at
a time. To select all Accounts in the list, use the check box next to Account ID.

n To select all accounts in the list, put a check in the box next to the Account ID header. All
accounts in the list will be selected.

l When all applicable Accounts have been selected, set an amount for each product to reprice in the
panel on the right side of the screen.

l Click Reprice to change the selected prices for the selected Accounts. Select Clear to remove the
reprice information from the product selections.
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4.6 TRN Download
Download the transactions file for a selected site and date range in this screen.

l Select a Site from the drop-down.

l Select a Start Date and End Date from the Date Selector..

NOTE: The date range must be less than or equal to 30 days.

l Click Download to download the Transaction file to your machine.
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Section 5 Reports Menu
The Reports Menu contains four (4) items:

l Reports: In this screen you can make 21 common reports.

l Scheduler: This screen lets you set up recurring events for:

n Report Options

n Export Data

l Downloads: This screen lets you download reports.

l Power BI Reports: Reports can be quickly generated through the Microsoft Power BI (Business
Intelligence) Service. These reports use the most frequently used data parameters for each report
type.

5.1 Reports
Repor ts> Repor ts

NOTE: Fields shown in Red below are required.

To Generate a Report:

l Select the radio button for the applicable report from the panel on the left side of the screen.

l Select the required options from the fields in the right panel of the screen for the applicable report. All
options are required (shown in red below).

l Click the Request Report icon in the lower left corner of the page to make the report.

l When the report is ready you will see a confirmation message that reads, "Success. Report generation
is in progress! Please navigate to the Downloads page to generate the report." Refer to "Downloads"
on page 61.

Available Reports

The Reports screen shows 21 of the most common reports that can be generated.

l Activity Detail by Driver (Card1): The report shows detailed driver-card transactions by Employee
Number. The report lists the Date and Time of the transactions, the Transaction Number, Site ID,
Vehicle Tag, Short Name, Account number, Odometer entry, Product ID, Pump and Hose ID,
Miscellaneous keyboard entry information, Price (per gallon), Quantity and the total monetary Amount
of the transactions. Totals for number of Transactions, Total Quantity and Amount for each Employee
number are shown below each entry. Grand Totals for number of Transactions, Total Quantity and
Amount are shown at the end of the report. Select a Date and Time range from the Date and Time
Selectors and a Starting Card # and Ending Card # from the drop-down fields.

l Activity Detail by Vehicle (Card2): The report shows detailed driver-card transactions by Vehicle ID.
The report lists the Date and Time of the transactions, the Transaction Number, Site ID, Vehicle Tag,
Short Name, Account number, Odometer entry, Product ID, Pump and Hose ID, Miscellaneous
keyboard entry information, Price (per gallon), Quantity and the total monetary Amount of the
transactions. Totals for number of Transactions, Total Quantity and Amount for each Employee
number are shown below each entry. Grand Totals for number of Transactions, Total Quantity and
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Amount are shown at the end of the report. Select a Date and Time range from the Date and Time
Selectors and a Starting Card # and Ending Card # from the drop-down fields.

l Activity Detail by Account for Driver (Card1); This report groups transactions by Account Number,
then by Driver card. The sort is by Driver (Employee) Number. The report also shows the total number
of transactions for individual cards. Transactions are listed in ascending, chronological order by Date
and Transaction Number. The report shows information on transactions based on the account and its
related cards. The report lists the Date and Time of the transactions, the Transaction Number,
Employee Number, Site ID, Site Short Name, Odometer entry, Product ID, Pump and Hose ID, Miles
per Gallon, Distance, Miscellaneous keyboard entry information, Price (per gallon), Quantity and the
total monetary Amount of the transactions. Totals for Accounts and Cards show below each Account
entry. Select a Date and Time range from the Date and Time Selectors and a Starting Account # and
Ending Account # from the drop-down fields.

l Activity Detail by Account for Vehicle (Card2): This report groups transactions by Account
Number, then by Vehicle card. The sort is by Vehicle Number. The report also shows the total number
of transactions for individual cards. Transactions are listed in ascending, chronological order by Date
and Transaction Number. The report shows information on transactions based on the account and its
related cards. The report lists the Date and Time of the transactions, the Transaction Number,
Employee Number, Site ID, Site Short Name, Odometer entry, Product ID, Pump and Hose ID, Miles
per Gallon, Distance, Miscellaneous keyboard entry information, Price (per gallon), Quantity and the
total monetary Amount of the transactions. Totals for Accounts and Cards show below each Account
entry. Select a Date and Time range from the Date and Time Selectors and a Starting Account # and
Ending Account # from the drop-down fields.

l Product Totals by Site: This report lists product usage in a year-at-a-glance format. The report is
sorted by product ID and shows product volume totals on a month-by-month basis for each site. A
grand total of product usage for the year is also shown. Select a Year, then a Starting Product ID and
Ending Product ID from the drop-down fields.

l Pump Totals by Site: This report lists total transactions and product volume by Pump and Hose and is
sorted by ascending site number. Select a Date and Time range from the Date and Time Selectors
and a Starting Site ID and Ending Site ID from the drop-down fields.

l Network Transactions by Card Type: This report shows Transactions for Card Types by Site ID. The
report shows Card Type, Date, Time, Card number, Price (per gallon), Quantity and the total monetary
Amount of the transactions. . Totals are shown for Card Type and Site and a Total Summary for all
sites. Select a Date and Time range from the Date and Time Selectors and a Starting Site ID and
Ending Site ID from the drop-down fields.

l Network Transactions by Site: This report is sorted first by Site ID, then Account and finally by Card
Type. The report shows Date & Time, Transaction Number, Product and Pump/Hose ID, Card Number
and Authorization Number, Account and Trace Number, Entry #1-6, Price (per gallon), Quantity and
the total monetary Amount of the transactions. Totals for Card Type, Account and Site are shown at the
end of the report. Select a Date and Time range from the Date and Time Selectors and a Starting Site
ID and Ending Site ID from the drop-down fields.

l Odometer Exceptions: This report lists all transactions that have been flagged with bad odometer
data. The report lists the Date and Time of the transactions, Transaction Number, Vehicle Tag and
Name, Employee number and Name, Odometer entry, Reason why it was flagged for a bad odometer
and the total quantity of the product. There are no options to select for this report.

l Incomplete Transactions: This report is sorted by Record ID and shows a Reason for failure. The
records are listed in order by date and time. The report shows Site ID and Transaction Number,
Product ID and Pump/Hose ID, Employee Number and Vehicle Tag, Account Number and Termination
Code, PPG (Price per Gallon) and Quantity and Transaction Total and Odometer. Select a Date and
Time range from the Date and Time Selectors.
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NOTE: For more information about Termination Codes see M00-051.00
FSC3000 Command-Line Configuration.

l Activity Detail Report by Site for Driver: This report groups transactions first by Site ID, then in
ascending chronological order by Driver ID. The report gives detailed information on Date and Time of
transaction, Transaction Number, Vehicle ID, Account, Account Short Name, last Odometer entry,
Product Name, Pump and Hose ID, Price, Quantity of product, and total monetary Amount of
transactions. Totals for each Driver are shown below each Driver entry for Transactions, Quantity and
Amount. Select a Date and Time range from the Date and Time Selectors and a Starting Site ID and
Ending Site ID from the drop-down fields.

l Summary Report by Site (Account): This report groups Account activity at each site. The activity
includes Account Number, Account Name, number of Transactions, Total Quantity of each account’s
transactions and the Total monetary Amount of those transactions. Select a Date and Time range from
the Date and Time Selectors and a Starting Site ID and Ending Site ID from the drop-down fields.

l Pump Totals for Product: This report shows Transaction totals for each pump at a site and is sorted
first by Site ID, then by Product ID and Product Name. The report shows Pump and Hose ID, number of
Transactions and Total Quantity for the product for the site. Select a Date and Time range from the
Date and Time Selectors and a Starting Site ID and Ending Site ID from the drop-down fields.

l Account Card Listing: This report is sorted by the Account ID and Name. The report shows Card
Number, Card Name, Card Type and the Short Name. For each card, related settings are listed (e.g.
PIN, Expiration Date, Monthly Allocation etc.) and there is a table that shows Multi-trucking Verified
Prompts and ChipKey settings (where applicable). Select a Starting Account # and an Ending
Account #.

l Activity Summary Report by Account for Product: This report contains single-line descriptions of
transactions. The transactions appear first by Account, then grouped by product ID, then in ascending
chronological order. The report shows Product ID, Product Name, number of Transactions, Total
Quantity and Total Amount. Totals for Account are shown at the bottom of each Account entry. At the
end of the report is a Report Product Totals section listed by Product ID. Select a Date and Time range
from the Date and Time Selectors and a Starting Account # and Ending Account # from the drop-
down fields.

l Activity Detail by Site for Accounts: This report groups transactions first by site ID, then by Account
number, then in ascending chronological order by account number. The report gives detailed
information on Date and Time of transaction, Transaction Number, Vehicle ID, Driver ID, Driver Name,
last Odometer entry, Product name, Pump and Hose ID, Price and Quantity of product, and total
monetary Amount of transactions. Select a Date and Time range from the Date and Time Selectors
and a Starting Site ID and Ending Site ID from the drop-down fields.

l Activity Detail Report by Site for Vehicle: This report groups transactions first by Site ID, then by
Vehicle. The report gives detailed information on Date and Time of transaction, Transaction Number,
Driver name, Account, Account Short Name, last Odometer entry, Product name, Pump and Hose ID,
Miscellaneous keyboard entry, Price and Quantity of product, and total monetary Amount of
transactions. Select a Date and Time range from the Date and Time Selectors and a Starting Site ID
and Ending Site ID from the drop-down fields.

l Product Totals for Sites by Date: This report shows transaction totals for each Pump/Hose at a site
and is sorted by Product, then Site ID. The report shows the number of Transactions and Total
Quantity for each Pump/Hose position. Select a Date and Time range from the Date and Time
Selectors and a Starting Site ID and Ending Site ID from the drop-down fields.
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l Activity Summary Report by Account for Driver: This report groups Driver activity for an Account.
The activity includes Account Number, Account Name, Driver, Driver Name, number of Transactions,
Total Quantity of each account’s transactions and the Total monetary Amount of those transactions.
The information is then listed by Product ID, Product Name, number of Transactions, Total Quantity of
each transaction and the Total monetary Amount of those transactions. Select a Date and Time range
from the Date and Time Selectors and a Starting Account # and Ending Account # from the drop-
down fields.

l Activity Summary Report by Account for Vehicle: This report groups vehicle activity for an
Account. The activity includes Account Number, Account Name, Vehicle, Vehicle Name, number of
Transactions, Miles Traveled/MPG, Total Quantity of each account’s transactions and the Total
monetary Amount of those transactions. The information is then listed by Product ID, Product Name,
number of Transactions, Total Quantity of each transaction and the Total monetary Amount of those
transactions. Select a Date and Time range from the Date and Time Selectors and a Starting
Account # and Ending Account # from the drop-down fields.

l Account Card Listing Short Version: This report shows the Account ID and Name, and detailed card
information for cards related to the account. The report will show the Total Number of Cards related to
an Account by Driver and Vehicle and includes, Driver/Vehicle Card Number, Card Name, User 1, User
2 and Media 1. Select a Date and Time range from the Date and Time Selectors and a Starting
Account # and Ending Account # from the drop-down fields.

5.2 Scheduler
Repor ts > Schedu ler > Create Schedu le

The Scheduler Table View shows events that have been previously scheduled. The table shows the Event
Name, Event Type, Event Status, Created Date and Last Execution Date.

There are two (2) Event Types that can be scheduled; Report Options and Export Data. They are configured
the same as the menu items they represent.

Click the Add ( ) button to open the Create Schedule page.

NOTE: Fields shown in Red below are required.

Scheduler Details

l Enter a Name for the event in the Event Name field.

l Select an Event Type from the drop-down.

n If Report Options is selected, configure a selected report the same as in "Reports" on page 57.

n If Export Data is selected, configure the parameters the same as in .

n If Export TRN is selected, configure the Display Fields the same as in .

l Under User Email, select the applicable Email Recipients who will receive the scheduled data.

l Under Scheduler Frequency, select one of the two:

n Schedule (Once): To schedule the selected event data to be sent to the selected recipients
one time:

v Select a Date from the Date Selector.

v Select a Time from the Time Selector.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 60



n Recurring: To schedule the selected event data to be sent to the selected recipients as a
recurring event:

v Select an Interval from the drop-down (hours, days, weeks, months).

v Select a Date and Time from the Date and Time Selectors to start the first
occurrence.

v To specify an end to the recurrence, enable the Until slider and select a Date from
the Date Selector.

l Click the Save button to save this configuration or Cancel to return to the Table View.

5.3 Downloads
The Downloads page contains the data for reports that were requested on the Reports screen. This Table
View shows the Report Name, Report Generation Date and the Report Date Range.

Click theDownload ( ) icon for an applicable report in the table to download it to your computer.

NOTE: Records in "Downloads" will only be available for 24 hours. After 24 hours, DX Fleet
removes a record from the list.
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5.4 Power BI Reports
Repor ts > Power BI Repor ts

The Power BI Reports page shows tiles for the available reports that can be made through the Power BI
Service.

l Select the tile of the applicable report.

TIP: There is a Report Category filter field at the top of the screen to the left of the Search
Report field. Use this drop-down to filter by:

Account Reports
Card Reports:
Product Reports
Site Reports
Transaction Reports

l The Parameters filter page will come up.

l Use the controls (date selectors, drop-down menus) to select the applicable parameters for your
report. Required fields will be marked "Required."

l Click the View Report button at the far right of the parameters bar. The report will come into view.

l The top menu bar of the report gives you more options for the report that was just made.

n Use the Print option in the File drop-down to open a print dialogue.

TIP: You can also click the Print Now button at the right of the menu bar to quickly open a
print dialogue.

n In the View drop-down, you can select Page View to see the report as it would look in a printed
output. To see the default view, select Default.

n The Export drop-down gives you eight (8) selections of the most used file types where you can
send and output your report. Select one of the file types to download to your machine.

n When you are in Page View you can click the Page Settings button to adjust the size and
orientation of the page.

5.5 Power BI Report Descriptions
The descriptions of the available reports is sorted from left to right by row as the tiles are arranged on the
screen.

First Row

l Activity Detail Report by Account for Driver: This report sorts by Account, then by Vehicle Tag. The
report lists the Date and Time of transactions, the Transaction Number, Employee Number, Site ID and
Name, Odometer entry, Product, Pump and Hose ID, Mpg (Miles per gallon), Distance, Price, Quantity
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and Amount of the transactions. Transaction Totals show for all Vehicle IDs listed. Select a Date
Range from the Date Selector and Account(s) from the drop-down. Click View Report.

l Activity Detail Report by Account for Vehicle: This report sorts by Account, then by Vehicle Tag
and Name. The report lists the Date and Time of transactions, Transaction Number, Employee
Number, Site Number and Name, Product, Pump and Hose ID Miles per gallon, Odometer reading,
Distance traveled, Miscellaneous Keyboard Entry information, Price, Quantity and the Amount of the
transactions. Select a Date Range from the Date Selector and Account(s) from the drop-down. Click
View Report.

l Activity Summary Report by Account for Driver: This report groups driver activity for an account.
The report includes Account Number, Account Name, Driver, Driver Name, number of Transactions,
Total Quantity of each account’s transactions and the total Amount of those transactions. Totals for
Account show for Quantity and Amount below each Account entry. Totals for Report show at the end of
the report. There is also a summary of transactions listed by Product ID at the end of the report. Select
a Date Range from the Date Selector and Account(s) from the drop-down. Click View Report.

l Activity Summary Report by Account for Product: This report shows Transactions first by
Account, then grouped by Product ID and Name. A subtotal at the end of the report is shown for each
Account that totals Quantity and Amount for all products for each Account. There is also a summary of
transactions listed by Product ID at the end of the report. Select a Date Range from the Date Selector
and Account(s) from the drop-down. Click View Report.

l Activity Summary Report by Account for Vehicle: This report groups vehicle activity for Accounts.
The report shows Account Number, Account Name, Vehicle, Vehicle Name, number of Transactions,
Miles Traveled/MPG, Total Quantity of transactions and the Total Amount of those transactions. There
is also a summary of transactions listed by Product ID at the end of the report. Select a Date Range
from the Date Selector and Account(s) from the drop-down. Click View Report.

l Detail Invoice by Account For Driver: This report groups transactions by Account, then by Product.
The report shows transaction Date, Driver ID and Name, Vehicle, last Odometer entry, Pump and Hose
ID, product Price, Total Quantity and Total Amount. A summary of Totals for Cards and Totals for
Product shows below each Product entry. Totals for Account show at the end of each Account entry.
Select a Date Range from the Date Selector and Account(s) from the drop-down. Click View Report.

l Detail Invoice by Account For Vehicle: This report groups transactions by Account, then by Product.
The report shows transaction Date, Vehicle ID and Name, Driver, last Odometer entry, Pump and Hose
ID, product Price, Total Quantity and Total Amount. A summary of Totals for Cards and Totals for
Product shows below each Product entry. Totals for Account show at the end of each Account entry.
Select a Date Range from the Date Selector and Account(s) from the drop-down. Click View Report.

Second Row

l Simple Invoice By Account For Driver: This report groups transactions by Account, then by Product
ID. The report includes Driver ID and Name, Number of Transactions, Price, Total Quantity and Total
Amount of the transactions. Totals for Products shows below each Product entry. Totals for Account
shows below each Account entry. Select a Date Range from the Date Selector and Account(s) from
the drop-down. Click View Report.

l Simple Invoice By Account For Vehicle: This report groups transactions by Account, then by
Product ID. The report includes Vehicle ID and Name, Number of Transactions, Price, Total Quantity
and Total Amount of the transactions. Totals for Products shows below each Product entry. Totals for
Account shows below each Account entry. Select a Date Range from the Date Selector and Account
(s) from the drop-down. Click View Report.

l Activity Detail by Account For Product: This report contains single-line descriptions of transactions.
The transactions show first by Account and then are grouped by Product ID and Name. The report
includes transaction Date and Time, Transaction Number, Site ID, Vehicle ID, Driver ID and Name, last
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Odometer entry, Pump and Hose ID, Price, Quantity and Amount of the transactions. Product Totals
show below each Product entry. Account Totals show below each Account entry. Select a Date Range
from the Date Selector and Account(s) from the drop-down. Click View Report.

l Transaction Summary by Account for the Year: This report is sorted by Account ID and Account
Name. The report shows money transaction Amount totals, Quantities and Number of Transactions for
each month in a year for each account. Yearly Totals are shown at the end of each line. Select a
Report Year and Account(s) from the drop-downs. Click View Report.

l Transaction Summary Information By Account: For each Account selected, this report shows the
Account ID and Name, a summary of monetary Amount, Quantity and number of Transactions for the
Current Month, Year-to-Date and Life -to-Date. Select the Year, Month and Account Number(s) from
the drop-downs. Click View Report.

l Activity Detail Report by Driver: The report shows driver transactions for the selected date range by
Employee number and Driver Name. The report lists the Date and Time of each transaction, the
Transaction Number, the Site ID, Vehicle Tag number (where applicable), Short Name, Account ID,
Odometer entry, Product ID, Pump and Hose ID, Price, Quantity and the Amount of the transaction.
Total number of Transactions and Quantity and Amount totals show at the bottom of each Driver
summary. A Grand Total of Transactions, Quantity and Amount show at the end of the report. Select a
From Date and To Date from the Date Selector and Driver Number(s) from the drop-down. Click
View Report.

l Activity Detail Report by Vehicle: The report shows vehicle transactions for the selected date range
by Vehicle Tag and Vehicle Name. This report shows the Date and Time of each transaction,
Transaction number, Site ID, Employee Number and Name, Account ID, Product ID, Pump and Hose
ID, Miles per Gallon, Odometer entry, Distance traveled, Miscellaneous Keyboard Entry information,
Price, Quantity and the Amount of the transaction. A summary of Transaction total, Cost per mile,
Average MPG, total Distance and Quantity and Amount totals show at the bottom of each Vehicle
summary. Select a From Date and To Date from the Date Selector and Driver Number(s) from the
drop-down. Click View Report.

Third Row

l Simple Invoice by Driver: This report lists individual transactions for driver cards and single cards
and is sorted by Driver ID. The report shows Date and Time of the transactions, Transaction Number,
Site ID, Product, Vehicle ID, last Odometer entry, Pump and Hose ID, Quantity and the Amount of each
transaction. Totals for Product show at the bottom of each Product entry and Totals for Driver show
below the Driver entries. Select a From Date and To Date from the Date Selector and Driver Number
(s) from the drop-down. Click View Report.

l Simple Invoice by Vehicle: This report lists individual transactions for a vehicle card and is sorted by
Vehicle ID. The report shows the Date and Time of transactions, Transaction Number, Site ID, Product
name, Driver ID, last Odometer entry, Pump and Hose ID, Price, Quantity and Amount of each
transaction. Totals for Product show at the bottom of each Product entry and Totals for Vehicle show
below the Vehicle entries. Select a From Date and To Date from the Date Selectors and Vehicle
Number(s) from the drop-down. Click View Report.

l Activity Summary Report by Driver: This report lists transactions by the Driver ID. The report shows
the Driver ID and Name, number of Transactions, Total Quantity and the Total Amount of the
transactions. Select a From Date and To Date from the Date Selector and Driver Number(s) from the
drop-down. Click View Report.

l Activity Summary Report By Vehicle: This report lists transactions Vehicle ID. The report shows the
Vehicle ID and Name, number of Transactions, Miles/MPG, Total Quantity and the Total Amount of the
transactions. Grand Totals are shown at the end of the report. Select a From Date and To Date from
the Date Selector and Vehicle Number(s) from the drop-down. Click View Report.
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l Product Totals for Sites by Date: This report lists product usage in an at-a-glance format for the
selected date range. The report is sorted by product ID and Name, then by Site ID and Name. The
report shows Pump and Hose ID, total Transactions and Total Quantity for the specified hose and
pump. Select a From Date and To Date from the Date Selector and Site ID(s) from the drop-down.
Click View Report.

l Product Totals by Site: This report lists product usage in a year-at-a-glance format. The report is
sorted by Product ID and shows product Quantity totals month-by-month for each site. Monthly totals
for all products and a grand total for Quantity is also shown. Select a Report Year and Product ID(s)
from the drop-down fields.

l Activity Detail Report by Site for Accounts: This report groups transactions first by Site ID, then by
Account number, then in order by Transaction number. The report gives information on Date and Time
of transaction, Transaction number, Vehicle ID, Driver, Driver Name, last Odometer entry, Product ID,
Pump and Hose ID, Price, Quantity, and Amount. Select a From Date and To Date from the Date
Selector and Site ID(s) from the drop-down. Click View Report.

Fourth Row

l Activity Detail Report by Site for Driver: This report groups transactions by site ID, then by Driver ID
and name. This report gives information on Date and Time of transaction, Transaction number, Vehicle
number, Account number, Account Name, Odometer entry, Product name, Pump and hose ID,
Miscellaneous Keyboard Entry, Price, total Quantity and total Amount of the transaction. Select a From
Date and To Date from the Date Selector and Site ID(s) from the drop-down. Click View Report.

l Activity Detail Report By Site For Vehicle: This report groups transactions first by Site ID, then by
Vehicle ID. The report shows Date and Time of transaction, Transaction number, Driver ID, Account
Number, Account Name, Odometer entry, Product name, Pump and hose ID, Miscellaneous keyboard
entry, Price, Quantity, and Amount of each transaction. Select a From Date and To Date from the
Date Selector and Site ID(s) from the drop-down. Click View Report.

l Activity Summary Report By Site For Account: This report shows Account transactions by Site ID.
The report gives information on Account ID, Account Name, Transaction totals, Total Quantity and
Total Amount. Select a From Date and To Date from the Date Selector and Site ID(s) from the drop-
down. Click View Report.

l Network Transactions by Site: This report groups transactions first by Site ID, then Account Name
and then Cart Type. The report shows information on transaction Date and Time, Transaction Number,
Product ID, Pump and hose ID, Card Authorization Number, Account Trace Number, Entry 1-6, Price,
Quantity and Amount for each Transaction. Select a From Date and To Date from the Date Selector
and Site ID(s) from the drop-down. Click View Report.

l Pump Totals: This report lists total transactions and product Quantity by pump for the selected Sites
and selected date range. The reports shows Pump and hose ID, Product ID, Product Description,
number of transactions for each Pump/hose and Quantity. Site grand totals are shown for Transactions
and Quantity. Select a From Date and To Date from the Date Selector and Site ID(s) from the drop-
down. Click View Report.

l Pump Totals for Product: This report shows transaction totals for each pump at a site. It also gives a
detailed report on site details, Pump and hose ID, Product ID, Product Name, number of Transactions
Total Quantity and Total Amount for the product for the site. Select a From Date and To Date from the
Date Selector and Site ID(s) from the drop-down. Click View Report.

l Activity Detail by Site for Accounts with Vehicle: This report groups transactions by Site ID, then
Account number, then by the total number of transactions for individual cards. The report lists Date and
Time, Vehicle ID, Vehicle Name, Odometer entry, Product, Pump and hose ID, Price, Quantity and
Amount of each Transaction. Account Totals are shown for total number of Transactions, Average
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Price, total Quantity and total Amount. Select a From Date and To Date from the Date Selector and
Site ID(s) from the drop-down. Click View Report.

Fifth Row

l Network Transactions By Site Summary: This report shows a summary of network transaction data
for the selected date range and Site ID(s). The report shows a total Number of Transactions, Total
Quantity and Total Amount for each Site ID listed. Report Totals by column are shown at the bottom of
the report. Select a From Date and To Date from the Date Selector and Site ID(s) from the drop-
down. Click View Report.

l Site Totals By Product: This report shows product Quantity totals month-by-month for each site.
Monthly totals for all products and a grand total for Quantity is also shown. Select a Report Year and
Site ID(s) from the drop-down fields.

l Activity Summary Report By Site For Driver: This report groups Driver card activity for each Site ID.
Activity shown for each card includes Driver ID, Driver Name, number of Transactions, Total Quantity
and Total Amount of each transaction. Totals for Site are shown below each Site entry. Select a From
Date and To Date from the Date Selector and Site ID(s) from the drop-down. Click View Report.

l Activity Summary Report by Site for Vehicle: This report groups Vehicle card activity for each Site
ID. Activity shown for each card includes Vehicle ID, Vehicle Name, number of Transactions, Total
Quantity and Total Amount of each transaction. Totals for Site are shown below each Site entry. Select
a From Date and To Date from the Date Selector and Site ID(s) from the drop-down. Click View
Report.

l Incomplete Transactions: This report shows a summary of incomplete Transaction data for a
selected date range sorted by Record ID and indicates the Reason for Failure. The report shows
stacked column data: Site ID/Transaction Number, Product/Pump, Date/Time, Employee
Number/Vehicle Tag, Account Number/termination Code, PPG (Price Per Gallon)/Quantity and
Transaction Total/Odometer. Select a From Date and To Date from the Date Selector. Click View
Report.

l Network Transactions By Card Type Detail: This report shows details for card activity for a selected
date range and is sorted by Site ID (the row also shows Site Name and Address) and Card Type. The
report shows Card Type, transaction Date and Time, Card number, Product, Price, Quantity and total
Amount. Select a From Date and To Date from the Date Selector and Site ID(s) from the drop-down.
Click View Report.

l Odometer Exceptions: This report shows odometer exception data for a selected date range. The
report shows Date, Time Transaction Number, Driver and Name, Odometer input, Reason and
Quantity. Select a From Date and To Date from the Date Selector. Click View Report.

Sixth Row

l Activity Detail Report By Misc Keybd: This report sorts transactions by miscellaneous keyboard
entry. The report displays the date and time of transactions, transaction number, site number, river-
card number, driver-card name, vehicle-card number, vehicle-card name, account number, product
name, pump and hose ID, and the total monetary amount of the transactions. It also includes the
number of transactions for each miscellaneous keyboard and the grand total of the transactions. "Enter
a Misc: Miscellaneous Keyboard is a generic prompt that can be presented during fueling to collect any
numeric entry required. These field labels can be programmed to help identify the value entered." on
page 49 Select a From Date and To Date from the Date Selector and Site ID(s) from the drop-down.
Click View Report.

l Activity Summary Report By Misc Keybrd: This report sorts transactions by miscellaneous
keyboard entry. The report shows Miscellaneous Keyboard entry, Number of Transactions, Total
Quantity and the Total Amount of the transactions. It also includes the grand totals for Transactions,
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Total Quantity and Total Amount. Select a From Date and To Date from the Date Selector and Site ID
(s) from the drop-down. Click View Report.

l Incomplete Transactions Detailed: This report shows a detail of incomplete Transaction data for a
selected date range sorted by Record ID and indicates the Reason for Failure. The report shows Site
ID, Date and Time, Transaction Number, Terminal Code, Driver ID, Vehicle ID, Account Number,
Product ID, Pump and Hose ID, Driver Name, Vehicle Name, Account Name, Misc Keyboard entry,
Odometer entry, PPG (Price per Gallon), Quantity and Transaction Total. Select a From Date and To
Date from the Date Selector. Click View Report.

l Network Transactions Sorted By User Entry #1-#4: These reports are sorted by the Network sorted
by User Entry number selected from the report listing, Network Sorted by User entries 1-9, that are
used by host network-based cards. Also included in the report will be the Date, Time, Site ID, Pump
and Hose ID, Product, Card Type and Status, Account Name, Transaction Number, Card 1 number
and name, account name, User Entry 1-9 data entry, Price, Quantity, Price and Amount. Each report
will also include a grand total for the quantity and Amount values. Select a From Date and To Date
from the Date Selector and Site ID(s) from the drop-down. Click View Report.
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Seventh Row

l Network Transactions Sorted By User Entry #5-#9: See above

l Network Transactions By Card Summary: This report shows details for card transactions for a
selected date range and is sorted by Site ID. The report shows Network Ark Type, Number of
Transactions, Total Quantity and Total Amount for each card type. Site Totals are also shown below
each Site listing. Grand Totals are shown as a Total Summary at the bottom of the report. Select a
From Date and To Date from the Date Selector and Site ID(s) from the drop-down. Click View
Report.

l Network Transactions by Date: This report gives a line-by-line list of all network authorized card
transactions (i.e. any transaction that is not authorized by the Fuel Site Controller’s local card file) for a
selected date range. The report is sorted by transaction Date, then by Site ID and then by Product ID.
The report lists transaction Date and Time, Site ID, Transaction Number, network Card Number,
Account name, Authorization Number, Status, Product ID, Pump and Hose ID, Price, Quantity and
Amount. Product Totals for Quantity and Amount are shown below each Product listing. Site ID Totals
and Totals for each Date are also shown at the end of the listing. Report Totals show at the end of the
report. Select a From Date and To Date from the Date Selector. Click View Report.

Eighth Row

l Network Transactions By Product: This report gives a line-by-line list of all network authorized card
transactions (i.e. any transaction that is not authorized by the Fuel Site Controller’s local card file) for a
selected date range. The report is sorted by Site ID, then by Product ID, Account and finally, Card
Type. The report lists transaction Date and Time, Site ID, Transaction Number, network Card Number,
Account name, Authorization Number, Status, Product ID, Pump and Hose ID, Price, Quantity and
Amount. Card Type Totals for Quantity and Amount are shown below each Card Type listing. Account,
Product and Site ID Totals and Totals for each Account are also shown at the end of the listing. Report
Totals show at the end of the report. Select a From Date and To Date from the Date Selector. Click
View Report.

l Network Transactions By Product Summary: This report gives a list of network transactions for a
selected date range. The report is sorted by Site ID and lists transaction by Product Description,
Number of Transactions, Total Quantity and Total Amount for each product. Totals by Site ID are
shown below each Site listing. A Total Summary shows at the end of the report. Select a From Date
and To Date from the Date Selector and Site ID(s) from the drop-down. Click View Report.

5.6 Leading Zeros in Delimited Reports
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There are times when it is necessary to keep leading zeros in a .csv (comma separated values) report when
it is imported into an Excel file. Excel number formatted columns removes leading zeros by default (see the
image above) when a .csv file is opened. There are two ways to set up an import of a .csv file in Excel that
keeps the leading zeros.

5.6.1 Newer Versions of Excel (June 2017 version 1704 and later)
Open a new, blank Excel workbook.

1. Go to the Data tab.

2. Go to the Get & Transform Data tools.

3. Select the From Text/CSV icon.

Navigate to the applicable file in the Windows Explorer screen that comes up. Select the file and click
Import.

4. In the screen that opens, make sure comma is selected in the Delimiter field. Click Edit (in some
versions this button will be labeled "Transform Data").
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5. Number formatted columns will have a "123" icon. Click the 123 icon to open a drop-down.

6. Select the "ABC" Text icon. A dialogue box will open.

7. In the "Change Column Type" dialogue box, select the Replace Current button.
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8. The 123 icon will change to ABC and leading zeros from the source .csv file are now retained.

9. Click the Close and Load button at the top left of the screen.

10. The editor screen will close and the Excel sheet will populate with leading zeros retained in the
adjusted column.

5.6.2 Use the Text Import Wizard (older versions of Excel [2010-2016])
First you must open a new, blank Excel workbook. To open the Text Import Wizard:
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l Go to Data > Get Externa l Data > From Text . Navigate to the .csv file with the data you will
import. Click the file and the "Text Import Wizard" will open.

To configure a data report in Excel with leading zeros in the "Text Import Wizard":

1. Under Original Data Type, select the Delimited radio button.

2. Tick the My data has headers check box.

3. Click Next.

4. Under Delimiters, tick the Tab box to deselect it. Then, tick the Comma check box.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 72



5. Make sure that the Text qualifier in the drop-down is set to double quotes (").

6. Click Next.

Under Data preview you will see that the first column is highlighted and its header shows "General."

7. Under Column data format, select the Text radio button. The first column header changes to "Text."

8. Click Finish.

The default location for the data import is the Existing worksheet, beginning in cell A1. This can be changed if
necessary.

9. Click OK. The data will now open in the new Excel sheet but the leading zeros are now kept in the
newly formatted column (see the image below).
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Section 6 Settings Menu
The Settings menu is used to configure parameters for:

l "Sync" on the next page: All site time and date functions.

l "Job Status" on page 82: Shows the status of Job Categories (In Progress or ERROR)

l "Sites" on page 84: Site configuration

l "System Configuration" on page 153: Configuration of Global parameters for all sites.

l "Pricing" on page 171

l "Fuel Zones" on page 172

l "Terminal Window" on page 174

l "Audit Log" on page 177

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 75



6.1 Sync
Set t ings > Sync

6.1.1 System Time Settings

This section lets you configure the times used by the FSC3000 for site control and network processing.

Select the applicable site to be configured from the Active Site drop-down.

Configure the applicable parameters for the selected site.

NOTE: Fields shown in Red below are required.

1. System On/Off Time: Use the Time Selector controls in these fields to enter specified times when the
site is open for fueling.

2. Light On/Off Time: Use the Time Selector controls in these fields to enter specified times when your
“Fuel Island Terminals” will illuminate the Keypads for night time use.

3. Time Zone: Select the applicable Time Zone for the selected site from the drop-down.

4. UTC Offset: Some time zones can be offset from Coordinated Universal Time (UTC) by a number of
hours or, in some cases, the difference can be in 30 or 45 minute offsets (see "Coordinated Universal
Time" on page 194). A useful resource to find out if an offset is necessary for your Site location's time
zone can be found here. See additional information about UTC in the information panel below
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INFORMATION: An explanation of UTC from Wikipedia: The UTC offset is the difference in
hours and minutes from Coordinated Universal Time (UTC) for a particular place and date. It is
generally shown in the format ±[hh]:[mm], ±[hh][mm], or ±[hh]. So if the time being described is
one hour ahead of UTC (such as the time in Berlin during the winter), the UTC offset would be
"+01:00", "+0100", or simply "+01".

Every inhabited place in the world has a UTC offset that is a multiple of 15 minutes, and the
majority of offsets (as well as all nautical time zones) are measured in whole hours. There are
many cases where the national civil time (ignoring Daylight Saving) uses a UTC offset (time
zone) that is different to the theoretical one appropriate to its longitude.

5. On Hour Deviation: This is used for areas where time is shifted off the hour from the rest of the time
zone. For example, Times in India deviate 30 minutes from the rest of the +5 UTC Zone (see the
explanation of UTC, Coordinated Universal Time above). Select minutes from zero (0) to 59 in the
drop-down.

6. DST Observed: Select this check-box if your time zone uses Daylight Savings Time.

7. Activate Receipts Only Time: This is a time that is set to make receipt collection available after fuel is
stopped. It is recommended to set this time to approximately 15-30 minutes.

NOTE: All others settings are used by certain “Fleet Host” customers. It is recommended to
set theses value to process cards to a Private Fleet Host.

8. Receipts Only Time: If the "Activate Only Receipts" check-box has been selected above, select the
applicable time from theTime Selector in this field.

Click the Save button to save this configuration.
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6.1.2 Action Panel
The Action panel on the right of the screen contains more actions that can be done within the system.

Select the Active drop-down to select the applicable Action.

6.1.2.1 Read

When you select either Read "Site Settings" (settings that apply only to a specific site) or Read "Global
Settings" (settings that apply to all sites in your system) from this menu item, you will get a warning that
informs you that all Site or Global configuration information will be overwritten. Select Yes if you want to
proceed and follow the prompts.

6.1.2.2 Send
When you select either Send "Site Settings" (settings that apply only to a specific site) or Send "Global
Settings" (settings that apply to all sites in your system) from this menu item, you will get a warning that
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informs you that this will overwrite all the FSC3000's configuration information (see the image above under
"Read"). Select Yes if you want to proceed and follow the prompts.

6.1.2.3 Upgrade FSC3000 Firmware

This item is used to upgrade the firmware of the FSC3000. When you select this item, a list of available
software versions will come into view. Select the radio button for the applicable version and click the
Upgrade button. Follow the prompts.

NOTICE: This operation should not be used while pumps are in use! Check all statuses
first. Then, when you are certain that no transactions are in progress, close the system and
start the operation.

6.1.2.4 Reset the FSC3000

When you select this menu item you will get a warning that says "this will cause a warm start of the system
and then disconnect from site." This "warm start" is similar to a power restart of the FSC3000. The controller
goes through certain background tasks during this operation. To continue, select Yes.
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NOTICE: This operation should not be used while pumps are in use! Check all statuses
first. Then, when you are certain that no transactions are in progress, close the system and
start the operation.

6.1.2.5 Open/Close System

This menu item can be used to manually open or close a site. This means that the terminal can be made
operable or inoperable when this operation is used.

6.1.2.6 Initialize Peripherals

This causes the FSC3000 to reconfigure all devices running on Petro-Net at the site. For example, pump
controllers will be reconfigured with current prices and available pumps/positions and terminals reconfigured
with all of their options. Select Yes to begin.

6.1.2.7 System Start
The System Start command is a one-time command that activates the FSC3000 system, allowing
transactions to be processed. It can also be used following a Cold Start (upon first installation or after a
firmware upgrade) when passwords must be resetand new users created.
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NOTE: This item will be removed from the menu in a future release. It is recommended that
System Start be done through the Terminal Window (see "Terminal Window" on page 174).

6.1.2.8 Change Password

IMPORTANT: This menu item is to be removed in a future release.

You can change the three system passwords in this selection. Each Password can be up to six (6)characters
and is not case sensitive.

l Remote Access password: The Remote Access password is required when accessing the FSC3000
system using the internal dial-in modem or Ethernet network port. The default, case-sensitive
password is “hello”. This password will automatically be requested when you first connect to the
FSC3000. Once the Remote Access password is entered, the system prompt “r>” or "l>" will be
displayed (where r> = modem and l> = Ethernet).

l Partial Login Access: This is also referred to as the Main Password for your FSC3000 system. The
Partial Login Access password is accessible from the system prompt “r>” ">" or "l>". When “hello” is
entered, the system prompt “ENTER MAIN PASSWORD:” will be displayed. The default, case-
sensitive Partial Login Access password is “hello”. This password functions in two (2) ways. Once the
Partial Login Access password is entered, the Partial Login Access prompt will be displayed.

n Direct connected – “P>”

n Modem connected - “R>”

n Ethernet connected – “L>”

l Administrator: The Administrator (also referred to as Admin)is the predefined user who has access to
every command. It is recommended that the Admin account only be used if the “SET ADMIN, SET
NETWORK, or SET FLEET” commands are needed. The Admin account is limited in access to the
system through only a Direct or Dial-in connection. A User account is needed to access the
FSC3000™ system if a TCP/IP connection is in use. The Admin password should be stored in a safe
location. Once the Admin password is entered, the prompt “Admin>” will be displayed.

IMPORTANT: Due to the requirements of PA-DSS (see "Payment Card Industry Data Security
Standard" on page 193) compliance, password recovery is no longer available. It is up to the
system owner to secure the passwords. If the Administrator password is lost, the FSC3000 will
require a cold start and must be reprogrammed to regain Admin access.

For more information about Passwords in the FSC3000 refer to the M00-051.00 FSC3000 Command-Line
Configuration Manual.
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6.2 Job Status
Set t ings > Job Sta tus

The Job Status page shows the status of Job Categories listed in the left column. The status can be In
Progress, Success, Failed or ERROR.

If a job status shows an ERROR, the Job Message column will show the reason for the error.

Two (2) other columns will show the Create Date and the Complete Date of the job.

There are no active icons in the Manage column unless the Job Status column shows "Partial Success" for a
record row. This indicates that there are one or more "Failed" statuses within the Job Category.

When "Partial Success" shows in the Job Status column, a download icon will show in the Manage
column. Select the Download icon. A .pdf file will download to your device.

Open the .pdf file to see the list of Configuration Categories and their Status. The Status column will show
what configurations failed.

INFORMATION: Failed and ERROR statuses for operations on this page only show how a
failure or error occurred. These are typically not issues that the user can correct. These issues
can be addressed by the DFS team as they become aware of their occurrence. If you continue
to get a condition that causes a negative effect on your operation, please call the support line
at +1 877-679-8324.
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DEPENDENCY: The Job Categories column refers to actions listed in the "Action Panel" on
page 78 of the Sync menu item (Sett ings > Sync).
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6.3 Sites
Set t ings > Si tes

This table shows the currently configured sites in the system. Sites are configured during the site on-
boarding process. The table is not configurable. This view shows each site's:

l Site ID

l Site Name

l City

l Zip Code

l State

l Country

l SE (Service Engine) Status (Running, Not Running) (See "Service Engine" on page 194 of the DX Fleet
Glossary).

6.3.1 Manage Icons
In the Manage column of the Table View, there are four (4) icons that come into view when your mouse
hovers over a record row:

l Edit ( ): See below for information on how to edit Site parameters.

l Resend Cards ( ): If a Fuel Site Controller loses all of its data due to battery, power or any type of
equipment failure, this option resends all of the lost card and System Account information back to the
FSC3000. The Fuel Site Controller Card File must be empty to use this function.

l Start/Stop ( ): This icon can be used to start or stop the Service Engine. You can suspend Service
Engine communication with the FSC3000 if it is necessary to access functions to the FSC3000 through
a different means (i.e. Putty, Hyperterminal, Phoenix, ARTWare) on another port (e.g. TCP/IP port,
modem port). This can be necessary to do something in the FSC3000 that is not a function in DX Fleet.

IMPORTANT: Make sure to start the Service Engine again to continue DX Fleet
operations. The Service Engine will restart itself after eight (8) minutes.

l Restart Edge from the UI ( ): There can be times when the Edge device needs to be restarted to try
to correct an issue (e.g. the Edge is offline and needs to be put back online or, if certain features do not
operate correctly). You can click the Restart Edge icon in the Manage column to try to correct the
issue.

NOTE: The Restart Edge feature does not correct communication issues with the Edge
device. Contact Technical Support to resolve communication or other issues that cannot
be resolved by a restart.
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6.3.2 Edit:Site and Controller
The instructions that follow show the procedures to edit the individual Site records. Select the Edit icon ( )
in the Manage column to edit a Site.

The menu shown above will be on the left of the Edit screen that comes into view. Site and Controller is open
with Site shown by default.

6.3.2.1 Site Details
Site Details are entered during the on-boarding process and cannot be edited. the information shows:

l Site Name

l Short Name

l Organization

l Site ID

l Description

l Address

l Country

l State

l City

l Zip Code

l Time Zone
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6.3.2.2 Edit Controller Information

Select Controller from the left side menu.

The site controller's softwareSerial Number and current Firmware version are populated from initial
communication between DX Fleet and the FSC3000.

Select the controls for Additional Options applicable to this site.

l If you have AVI (See "Automatic Vehicle Identification" on page 191 for a description) installed at your
site, select this option.

NOTE: Refer to the appendix,"AVI: Automatic Vehicle Identification" on page 188 for information
on the AVI fields and controls in this section.
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n Display Type: Select from the drop-down.

v 2 X 16: This selection is applicable to K800 Hybrid and other legacy System2 FITs.

v Graphics: Use this selection for all other terminals. This is the default value for this
field.

n Enable Dual Language: Select this option to let the FSC3000 use two languages for
messages and prompts.

DEPENDENCY: When this check-box is ticked, the Language drop-down in "Message" on
page 97 and "Prompts" on page 98 will show "Language 1" and "Language 2."

l Enable the slider for Enable Journal Printer if a Journal Printer is installed at the site and connected to
your FSC3000 to print a hard copy of transactions as they occur. If this control is enabled the selections
that follow will come into view. Select if applicable:

n Printer Preferences

v Enable Auth(orization) on Error: Authorization will continue even if there is a
printer error. The FSC3000 will print when the Journal Printer is back online. If
youwant hard copy receipts for all of your transactions in real time leave this box
blank.

v Stop Line Skip Between Transactions: The printer adds a blank line between
each record. Select this option to have records print in sequence with no line break.

v Print log on first of month: This is a monthly PCI log files (see "Payment Card
Industry" on page 193).

n Additional Fields: The Journal Printer prints one line of data for each transasction. You can add
lines for:

v Prompt Responses

v Account Number and Card Number

v Account, Driver, Vehicle, Odom and Misc.

l Enable the slider for Enable USB Memory Key if applicable. If this control is enabled the selections
that follow will come into view. Select if applicable:

v Allow authorization if USB key is not inserted (see"Universal Serial Bus" on page 194)

v Phoenix Site ID (required when the USB feature is enabled). If you upgrade from
Phoenix software to DX Fleet, you must enter your assigned Phoenix Site ID to use
the USB feature.
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NOTE: The USB feature was included for users without a Journal Printer to have a means to
back up transaction data.

6.3.2.3 FSC COM Port Settings
On the right of the screen there is a settings tab for FSC - COM Port Settings.

l Select the applicable COM Port from the drop-down.

l Select the applicable Baud Rate from the drop-down.

6.3.2.4 ATG Settings
To the right of the FSC tab is another tab labeled ATG ( See "Automatic Tank Gauge" on page 191 of the DX
Fleet Glossary). Configure the ATG settings in this tab.

Select the radio button for the applicable ATG console.

Select the ATG device installed check box if applicable.

Enter the Device ID if applicable.

DEPENDENCY: Selections in this tab are used to populate the ATG Type in "ATG (Automatic
Tank Gauge) Configuration" on page 170.
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6.3.3 Tank and Pumps

There are three (3) tabs on this menu item to configure tanks, pump controllers and pumps.

6.3.3.1 Tank
This screen is used to configure the tanks in your system.

1. Select a Site from the site selection drop-down in the top left of the screen.

2. Select Tank and Pumps from the menu to expand the selection.

3. Select Tank from the expanded menu. The Tanks table view will show in the main panel.

4. The Tanks table view shows all configured tanks for the selected site.

5. To add a new tank, select the "+" icon in the top right of the page.

6. To edit a configured tank, select the Edit icon ( ) from the Manage column of the applicable tank to
be configured. The "Edit Tank Details" page will come into view.
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l Select a Tank number from the drop-down.

l The Tank ID will populate automatically.

l Select a Product Type for the tank from the drop-down.

Click theSave button.

6.3.3.2 Pump Controller
This screen is used to configure the Pump Controllers in your system.

1. Select a Site from the site selection drop-down in the top left of the screen.

2. Select Tank and Pumps from the menu to expand the selection.

3. Select Pump Controller from the expanded menu. The Pump Controller table view will show in the
main panel.

4. The Pump Controller table view shows all configured pump controllers for the selected site. The
columns show the Controller ID, Installed status of the controller, Unit Type (the Pump Control method
used) and if Hose Restrictions are allowed for the controller.

5. To add a new pump controller, select the "+" icon in the top right of the page.

6. To edit a configured pump controller, select the edit ( ) icon from the Manage column of the
applicable pump controller to be configured. The "Edit Pump Controller Details" page will come into
view.
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l Enable the slider for DPC (see "Direct Pump Control" on page 192) if applicable. If DPC is selected,
additional controls will come into view. These will be discussed below.

l Select the Installed check box if applicable. "Installed" means that the DPC is active and can be used
by a customer. You can remove the check when there are conditions where DPC components must be
made inactive/not available (e.g. repairs, maintenance). An error will show on the terminal screen to
show that this controller is not in operation.

IMPORTANT: Make sure to go back and select this check-box again in the DX Fleet
application when the task is complete. If this is not done, an error will continue to show on the
terminal screen.

l Select the Unit Type from the drop-down:

NOTE: See the section on Pump Control in the M1700 FSC3000 Legacy manual for complete
information on all current and legacy pump control methods.

n PCT (Pump Control Terminal): This pump control type can be configured for up to eight (8)
pump positions.

n K800 PCT: This pump control type can be configured for up toeight (8) pump positions.

n PCM (Pump Control Module): See M00-20-0340 PCM Installation, Operation and
Maintenance for information specific to Pump Control Modules.

n UPC (Universal Pump Control: This pump control type can be configured for up to four (4)
pump positions.

l Select a Controller ID from the drop-down. Numbers that have been configured for other controllers
will not be available in the drop-down.

DEPENDENCY: The controllers defined here will be the available selections in the Pumps for
Controllers drop-down under "Pump" on page 93.

l Select the Allow Hose Restrictions check box if applicable. This feature is only available if the DPC
slider is enabled or when UPC is selected in the Unit Type drop-down above. This gives the option to
use restrictions with this controller.

DPC Settings
When the DPC slider above is enabled, more configuration fields will come into view.
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Direct Pump Controller

NOTE: See the section on DPC (Direct Pump Control) in the M1700 FSC3000 Legacy manual
for complete information on DPC setup for Gilbarco, Gasboy and Wayne dispensers.

l Select the applicable Pump Type from the drop-down. The selections are Gilbarco, Gasboy and
Wayne.

l Select a Trans(action) Delay length from the drop-down. This is only required when Gilbarco is
selected as the Pump Type.

COM Port Setting
l Select the applicable Baud Rate, Parity, Data Bits and Stop Bits for the selected DPC controller.

Click the Save button.
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6.3.3.3 Pump
This screen is used to configure the Pumps connected to your system.

1. Select a Site from the site selection drop-down in the top left of the screen.

2. Select Pumps from the menu. The Pump Controller table view will show in the main panel.

3. The Pump table view shows all configured pumps for the selected site.

4. To add a new pump, select the "+" icon in the top right of the page.

5. To edit a configured pump, select the edit ( ) icon from the Manage column of the applicable pump
to be configured. The "Edit Pump Details" page will come into view.

l In the "Pumps" Add screen, select the applicable number from the Pumps for Controller drop-down. In
the "Edit Pump Details" screen, the number from the Pumps for Controller drop-down is selected
automatically and cannot be edited.
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DEPENDENCY: The available controller numbers are the Controller ID numbers set up under
"Pump Controller" on page 90.

l Select the applicable Position from the drop-down. This shows the available "Relay" positions
available from installed Pump Control Modules. For more information see M00-20-0340 PCM
Installation, Operation and Maintenance.

DEPENDENCY: In "Edit" mode the Pumps for Controller and Position fields will be grayed-out
and show that this pump has been configured from the setup in "Pump Controller" on page 90.

When a new pump is added, only pumps that were configured in the Pump Controller
configuration will be available in the Pumps for Controller drop-down. The only available
numbers in the Position drop-down will be numbers not configured in the Pump Controller
configuration.

l Select the Installed check box if applicable. "Installed" means that the pump is active and can be used
by a customer. You can remove the check when there are conditions where the pump must be made
inactive/not available(e.g. repairs, maintenance).

l Enter the Pump Number into the field.

l Select the Use Pump Sentry check box if applicable (This option disables the pump if three “Zero
Quantity” transactions occur in a row. This can show possible pump or pulser problems).

l Poll ID: This field is only available when Gasboy is selected under Direct Pump Controller above. This
is used to configure Gasboy pumps in the FSC3000. See the section "DPC – Gasboy Pump Mapping"
in M00.051-00 FSC3000 Command-Line Configuration.

l Supports Dollar Auth(orization): This field is only available when Gasboy is selected under Direct
Pump Controller above. Select this check-box to use this feature. See "Dollar Auth(orization)" on
page 191 for more information.

l Enter an applicable Max Quantity. This is the maximum amount of fuel you want this pump to
dispense.

l Pulses Per Unit: Specifies the number of pulses per unit of measure of product dispensed. See your
pulser manufacturer documentation for information on installation and setup. See "Pulser" on page 193.

l Ignore Handle on Auth(orization): Select this check-box if you want to permit a pump to be activated
if the pump handle is lifted before authorization is complete.

l Enter the applicable Timeouts:

n Handle (in seconds): This is the number of seconds after authorization that the pump handle
must be operated.

n Missing Pulse (in seconds): The maximum number of seconds between pulses.

n First Pulse (in seconds): This is the maximum number of seconds after the pump handle has
been activated before the first pulse is detected.

n Fueling (in minutes): This is the maximum number of minutes permitted to dispense product.
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A panel on the right side of the screen will show the available hoses to be configured.

l Select the applicable Product Type from the drop-down.

l Select the applicable Tank # from the drop-down.

l Enter the Totalizer (see "Totalizer" on page 194) from the pump. This tracks the amounts of fuel
actually dispensed by the pump. Set the Totalizer to the counter setting on the dispenser's meter.

l The Totals field cannot be edited. This shows the total amount of fuel that has been dispensed through
all transactions at this pump.

l Select the RFN# if applicable (applicable to AVI systems only). Here, you can map the RFN
numbers that were set up under "Edit Controller Information" (see "AVI: Automatic Vehicle Identification"
on page 188 for information on how to configure RFN numbers in an AVI system through DX Fleet.

Click the Save button.

6.3.4 Terminals
There are three (3) tabs on this menu item to configure terminals, messages and prompts.

6.3.4.1 Terminals

1. Select a Site from the site selection drop-down in the top left of the screen.

2. Select Terminals from the menu to expand the selection.

3. Select Terminals from the expanded menu. The "Terminals" table view will show in the main panel.

4. The "Terminals" table view shows all configured terminals for the selected site.

5. To add a new terminal, select the "+" icon in the top right of the page. The "Add Terminal Device" page
will come into view.

6. To edit a configured terminal, select the pencil icon from the manage column of the applicable terminal
to be configured. The "Edit Terminal Device" page will come into view.
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l In the "Terminals" Add screen select the applicable Terminal ID from the drop-down. In the "Edit
Terminal Device" screen, the number from the Terminal ID drop-down is selected automatically and
cannot be edited. The Terminal ID selected should match the ID number selected in the terminal
programming.

NOTE: When you add a terminal in the Add screen, the numbers for terminals that have been
configured before this terminal will not be available in the drop-down.

l Select the applicable Terminal Type from the drop-down.

l Enter a Decline Timeout in the field if applicable. Enter a numeric value (in seconds) from 1-60. This is
the amount of time a non-prompt message will remain on the terminal screen.

l Select the applicable Prompt Timeout from the drop-down (in increments of 5 seconds from 15-60).
This is the amount of time a prompt message will remain on the terminal screen.

l If a Reader Error is detected it will show in this field. Select the Clear button to clear the error.

l Select the applicable Display Type from the drop-down (Graphics, 2x16, 1X20).

l If the Receipts counter is detected it will show in this field. Select the Clear button to clear the counter.

A panel on the right side of the screen will show more selections that can be configured.

l Operation Status

n Select the Installed check box if the terminal is installed. "Installed" means that the terminal is
active and can be used by a customer. This will let the system poll the device.
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n Select Keyboard Accessif applicable. This enables the keyboard entry mode for "Insert Card"
at the terminal.

v If Keyboard Access is enabled, the Keyboard Length field will be enabled. Enter a
numeric value in the range of 1-32 digits.

l Receipt

n Select the Issue Receipt check box if applicable. This is for terminal installed receipt printers.

n Select the Unlimited check box if applicable. This control is enabled if Issue Receiptsabove is
checked. When checked, there is no history limit for printed Receipts.

n If Issue receipts is enabled, enter the applicable Days to Retrieve Receipts value (from 1-99
days).

l Pump Access

n Select the Limit Access to Pumps check box if applicable. This lets you specify which pumps
this terminal can activate.

v If Limit Access to Pumps is enabled, the Valid Pumps field will be enabled. Enter the
applicable values(pump numbers separated by commas).

l Click theSave button.

6.3.4.2 Message
Select a Site from the Site Selection drop-down in the top left of the screen.

The "Display Messages" table view shows all configured messages for the selected site.

l Select a Message Set from the drop-down that is applicable to your site.

l Select the applicable number for Language from the drop-down. If Dual Language is not used only "1"
will be available.

DEPENDENCY: Dual Language must be selected in Enable Dual Language under "Edit
Controller Information" on page 86

l Click the Load button. The selected message set will come into view in the display below the controls.
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IMPORTANT: This button is used to LOAD a selected default Message Set to be used for the
selected site. Once a Message Set is loaded for a site, the messages are saved as the site's
new Message Set. Whenever you select the Load button, whatever had been set as your
current Message Set will be overridden by the new default Message Set that you just loaded.
All messages that have been previously edited would be lost.

TIP: To edit a message, select the ( ) Edit icon in the Manage column of the row of the
message to be edited.

Type the new message in the active field in the Message column.

Select the ( ) Save icon in the Manage column of the row of the edited message.

6.3.4.3 Prompts
Select a Site from the Site Selection drop-down in the top left of the screen.

The "Display Prompts" table view shows all configured display prompts for the selected site.

l Select a Default Prompts Set from the drop-down that is applicable to your site.

l Select the applicable number for Language from the drop-down. If Dual Language is not used only "1"
will be available.

DEPENDENCY: Dual Language must be selected in Enable Dual Language under "Edit
Controller Information" on page 86

l Click the Load button. The selected default prompts set will come into view in the display below the
controls.

TIP: To edit a prompt, select the ( ) Edit icon in the row of the prompt to be edited.

Type the new prompt in the active field in the Message column. Select a Type from the drop-
down. Enter the applicable Min and Max Length values.

Select the ( ) Save icon in the Manage column of the row of the edited prompt.

In the Edit mode, type your prompt message in the Message column.

Select a response type from the drop-down in the Type column.
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Enter a minimum and maximum character length for the response in the Minimum and Maximum column
fields.

Select the Save ( ) icon in the Manage column to save the edited prompt information.

6.3.4.4 Receipt
Select a Site from the Site Selection drop-down in the top left of the screen.

There are two (2) tabs on this screen to set up Receipt Headers and Trailers.

Set up your Receipt Headers and Trailers on this screen. You can specify up to four (4) lines for Language 1,
Language 2 and Network.

NOTE: If you do not have your system configured to use the Dual Language feature,
Language 2 defaults to the primary language.

Click Save.

6.3.5 Networks
There are two (2) tabs on this page to configure new networks (Add Network) and see the networks that have
been configured (Added Networks). The Added Networks tab opens by default.

6.3.5.1 Added Networks
This tab shows a list of the site's configured networks and opens when you select Network in the menu.

NOTE: Up to seven (7) networks can be configured in the FSC3000. The networks that you
can configure are limited by the ones you have purchased with your FSC3000.

6.3.5.2 Add/Edit Network
There are four (4) tabs under Add Network :

l Network Information

l Host Configuration

l Fleet/Account

l ISO

Add/Edit Network Information
l Select a Site from the site selection drop-down in the top left of the screen.

l Select the applicable Network from the drop-down.
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l To edit a configured Network, select the edit ( ) icon from the Manage column of the applicable
Network to be edited. The Edit view for the selected Network will come into view.

l To add a new Network, select the Add Network tab.

IMPORTANT: Each Network can be configured differently. Therefore, each network's
configuration procedure will be shown separately in the next section.

See Network Configuration for instructions on how to configure parameters for all available Networks.

Host Config

After all networks have been set up, select the Host Config tab to set up the host configuration parameters.

Make the applicable selections in this screen for the applicable site. Here you will configure the primary and
secondary hosts and modem configurations.
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NOTE: A Secondary Host purchased flag for your FSC3000 is required to enable a secondary
host. A secondary host is useful to speed up transaction authorizations where more than one
network is in use.

1. Enable Secondary host for processing: To use a second host for processing card transactions the
option flag must have been purchased as a part of your FSC3000 purchase from DFS. Select this
checkbox to enable the feature in the application.

2. Select a connection type:

l Use TCP/IP connection device: Select this option if you use a TCP/IP device with direct
connection to the host.

l Use dial-out connection to host: Select this option when you use a modem or a Systek device
that emulates a modem for connection. The Modem Configuration options (see below) become
active when this option is selected. Use dial-out connection to host is selected by default.

3. Lock host to port: Select this option to lock the primary host port to a single network. All other
available networks will connect through the secondary port. When this option is selected, a list of
available networks will come into view under the header Specific to. Select the applicable network from
the available networks in the list.

NOTE: This option is only available when a secondary host is activated.

IMPORTANT: When a secondary host is in use it is recommended to only lock one of the
host ports to a specific network. If both ports are locked, no other networks can get fuel.

4. Select Print options:

l Print Price and total on receipt: Leave this selection un-checked to not print price and total on
receipts.

NOTE: For bank cards, the FSC3000 automatically prints price and total even if this box is
un-checked.

l Print Price per unit on use pump message: This tells the FSC3000 to show the price per unit on the
pump message.

l Force Capture Time (min): This is a global setting for the host to capture a transaction within the
specified number of minutes after a transaction is complete.

5. Select a Modem Configuration:
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When Lock Host to port is not selected, the Modem Configuration selection list will be shown on the
screen. These selections are based on modems that were sold by OPW-FMS:

l For 33.6k baud HOST modem: Select this option if a 33.6k baud rate modem is in use at the site.

l New 2400 baud HOST modem (purchased after 6/05): Use this setting for a modem purchased
after June, 2005.

l Old 2400 baud HOST modem (prior to 6/05) OR US Robotics: Use this setting for a modem
purchased before June, 2005 or when a US Robotics device is in use.

IMPORTANT: This is the default setting in the FSC3000 and is the preferred setting.
However, the purchase date of the modem should dictate your selection because the
initialization strings for these modems are different. This setting must be selected when a
Systek micronode or Abierto IP Gateway device is in use. For more information on the
Abierto and Systec devices see M00-20-6013 -IP Authorization Gateway and M00-20-
6019 - Micronode Gateway procedure guides under the Gateway andWireless product
category in the FMS Technical Library.

l User defined initialization string: This can be used as an override to the typical device setting if
needed.

IMPORTANT: This feature should only be used by those who understand modem
commands and their purpose.

Click Save to save the Host Configuration during site edit.

Fleet /Account

INFORMATION: To fully understand how the Fleet Table operates within the FSC3000, read
the sub-section Fleet Table under Network Management in the M00-051.00 FSC3000
Command-Line Configuration manual.

After you have completed Host Configuration, select the Fleet/Account tab.

Fleet/Account is often referred to as the Fleet Table. This is where you configure the specific settings for
limits and access phone numbers for each of the up to seven (7) networks you have available. Up to 20
entries can be programmed.

NOTE: This lets you set up different prompts for the same network card for different company
sites or locations.
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To edit a Fleet/Account configuration, select the ( ) Edit icon in the Manage column of the row of the
network to be edited. The edit screen will come into view.

There are three (3) sections in this screen, Fleet Account Information, Fueling Limit and A & B Codes.

1. Fleet Account Information

l Select the applicable Network Typeto be configured from the drop-down. The drop-down is populated
with the up to seven (7) networks that you previously configured in Networks above.

l Enter the applicable Prompt Sequence. The prompt sequence defines the order in which prompts are
presented to the driver after the driver swipes or enters a card.

l Enter the applicable Fleet Account Number: For this parameter you must have knowledge of the
cards in use and what the numbers represent (where the first six [6] digits are the ISO number, the next
up to 12 digits are the account number and the last four digits are the card number). The ACCOUNT
number is what is referenced in this field . Each network has different Account number lengths so you
must know what the account number is for the card to enter it into this field.

l Enter the applicable Fleet Account Name.

l Enter a Primary Phone Number and Secondary Phone Number in the fields.

2. Fueling Limit

IMPORTANT: When a fueling transaction is done, the system will look at all fueling limit
parameters that are set up in the system and only permit the lowest limit specified.

Depending on the network these settings are used to define the network authorization requested limits by
quantity (i.e. gallons) or currency.

l Enter the applicable Online limit. This is the maximum allowed when a host connection is available.

l Enter the applicable Offline limit: If you have Local Authorization set up, you can specify an offline limit
in this field.
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DEPENDENCY: Local Authorization must be enabled in each applicable Network's
configuration page. See the Network set up instructions for each applicable Network under
"Networks" on page 99.

3. A & B Codes

IMPORTANT: There can be network specific differences that can have an effect on the
information shown in the A & B Codes section of this screen. Different networks can have
different available selections. The possible selections are shown below.

l Select one of the radio buttons:

n Limit by Dollar: The A code will automatically show "1." The B code can be configured by the
user. When this is selected, a max dollar authorization value must be entered in the B Code
field.

n Limit by Quantity: The A code will automatically show "0." The B code cannot be configured
by the user. When this is selected the values entered for Online and Offline limits are applied
(see above).

n Force Visa and MasterCard transactions to auth(orize) at $1: In order to obtain the best
interchange rate for Petroleum based Visa and Mastercard transactions, these cards should
be authorized at $1 and have a final SALE of less than or equal to $75. While Visa and
Mastercard fleet cards must have a final sale less than or equal to $150. The A code will
automatically show "0." The B code cannot be configured by the user.

n Auth(orize) ALL transactions at Max Online Dollar Limit: If this option is not selected it will
cause your customers to incur a Credit Limit Hold on their cards for the "MAX Auth Amount"
configured in the ISO table. Debit card users will incur a temporary loss of funds based on this
limit, from their checking accounts. If this feature is used it will require that Visa and
MasterCard customers must pump more than $75 and Visa Fleet and Mastercard Fleet
customers must pump more than $150 to "re-swipe" their cards to continue fueling. The A
code will automatically show "1." The B code cannot be configured by the user.

IMPORTANT: Use of this option can incur a higher processing fee for each Visa
and Mastercard transaction.

n Prompt Cardholder for desired Dollar Authorization Amount: As a third option you can
choose to prompt the customer for a desired dollar amount. The entered value would then be
used to authorize their cards provided it is greater than the values shown above. The A code
will automatically show "2." The B code cannot be configured by the user.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 104



IMPORTANT: Use of this option can incur a higher processing fee for each Visa
and Mastercard transaction.

n The A Code will populate according to selections made above.

n Enter a B Code if it is activated as a user configurable field (only when Limit By Dollar is
selected).

NOTE: There can be network specific differences that can have an effect on the information
shown in the A & B Codes section of this screen.

Click Save to save the Fleet Account configuration.

ISO

INFORMATION: To fully understand how the ISO Table operates within the FSC3000, read
the sub-section ISO Table under Network Management in the M00-051.00 FSC3000
Command-Line Configuration manual.

The ISO table used on the FSC3000 is specifically design for the processing of bankcard and private fleet
cards under the networks; Buypass, NBS Bank, NBS Quarles and Paymentech. Other networks that process
MasterCard Fleet cards require the MasterCard Fleet card ISO table to be “Activated” before those cards will
process to their specific network.

For information about ISO, see "International Organization for Standardization" on page 192

To edit the table, select the Edit ( ) icon in the far-right column of the applicable ISO # to edit. The ISO edit
screen will come into view.
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By default the first 16 rows of the table are configured for most of the major cards and you cannot delete or
change most of the settings. To enable them for use you must check Active in the "Edit" view.

To configure an ISO Table entry (where applicable):

1. ISO Number: This is a non-configurable field.

2. Name: This is a 16 character card name for purposes of identification. It is recommended to not use
spaces.

3. ISO Card Format: This sequence of characters is used to define the layout of the Track 2 card data. It
tells the site controller how to identify the specific card type.

Character Meaning

I ISO #

C Card Number

L Luhn Check Digit

= Must be field separator

M Month

Y Year

X don't care digit or field separator

# don't care digit

0-9 must be specific digit

> don't check length to the end or alternate network card

4. ISO Range Minimum Value: This is the minimum range value used to identify the specific card

type.

5. ISO Range Maximum Value: This is the maximum range value used to identify the specific card

type.
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6. Max Authorization Dollar Amount: This field is used by Paymentech to define a card-specific dollar
authorization value. See the A&B Codes for Paymentech above.

7. Digits to Display/Print You can enter up to a maximum of 20 characters.

8. Select the applicable Card Type from the drop-down. This value associates the branding of the card to
the logic applied within the FSC3000 for purposes of identification and processing rules.

NOTE: If you configure the ISO for Paymentech and have enabled bankcard PINs, the
Prompt for PIN option is available. See Network Options for "Paymentech" on page 138.

9. Additional Selections

l Prompt for Bankcard security code: If you enable a bankcard security code under an applicable
network, you can request a security code for that card.

l Print Price on Receipt: If you select this field it will disable the feature to print the price and total on
the cardholder's receipt.

l Active: If this check-box is not selected, this card will not process.

10. Click the Allowed Products button. The Allow Products selection screen will come into view.

l Select all applicable Products in the list.

l Click OK to save and close the dialogue. Click Cancel to close the box and not save.

Click Save to save the ISO configuration during site edit.
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6.4 Network Configuration
This section shows instructions for the configuration of each available Network's settings.

"Atio.net" on the next page

"Buypass" on page 111

"CFN" on page 113

"COMDATA and Comdata POS" on page 116

"Company Card" on page 118

"EFS" on page 120

"Federated Co-op" on page 122

"FleetOne" on page 124

"Intevacon" on page 126

"Irving Oil" on page 128

"Kardtech" on page 130

"NBS BANK" on page 132

"NBS/FMGC (Fuelman/Gascard)" on page 134

"OPW Generic" on page 136

"Paymentech" on page 138

"Quarels" on page 140

"Quick Fuel" on page 143

"QUIKQ" on page 145

"Shell Canada" on page 147

"TCH" on page 149

"T-CHEK" on page 151
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6.4.1 Atio.net

1. Select Atio.netfrom the Network drop-down. The parameters for Atio.net network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.
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5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Merchant Information: Enter your Site or Merchant ID in this field.

Click Save to save the Network Information configuration during site edit.
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6.4.2 Buypass

1. Select Buypassfrom the Network drop-down. The parameters for Buypass network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.
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8. When using a Firstdata Micronode IP Converter (in place of a modem) for the processing of Buypass
network transactions you must select the Process transactions using the Firstdata Micronode
device check-box. See M00-20-6019 Micronode gateway Procedure Guide for more information.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. Download Phone: This option is provided in case Buypass changes the number. Under normal
circumstances you should not have to change this number.

11. Buypass Network Options: This feature allows the merchant/site owner to restrict fueling and/or
meet requirements (for required fuel training) before allowing credit cards to be processed at an
unattended site.

INFORMATION: For a full explanation about the options in this panel, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #13
Force Bankcard Secur i ty Code in M00-051.00 FSC3000 Command-Line Configuration.

12. AVS (Address Verification Service) Prompting: This option enables the prompting of ZIP Code
and/or House Number prompting. This network can be set up to prompt as a theft deterrent only. To
enable this feature, select the AVS Prompts button. The Address Verification Service(AVS) Prompts
pop-up will come into view. See "Address Verification Service" on page 191.

INFORMATION: For a full explanation about the options in this pop-up, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #14
AVS Prompt ing in M00-051.00 FSC3000 Command-Line Configuration.

Click Save to save the Network Information configuration during site edit.
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6.4.3 CFN

1. Select CFNfrom the Network drop-down. The parameters for CFNnetwork configuration will come into
view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
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parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: (Comdata only, not available for Comdata POS).

Select the Allow Local Authorization check-box to enable the Local Authorization option. The Local
Authorization option allows configuration of processing rules if the FSC3000 can authorize network cards
offline when the host is down. Not all networks support this feature. If you enable Local Authorization for a
specific host you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields can be activated:

l Pride Advantage Cards: Pride Advantage must be selected under CFN Network Options (See #9
below).

l CFN Cobranded Cards: CFN/Fuelman Dual network cards must be selected under CFN Network
Options (See #9 below).

l Chevron Diesel Advantage: Chevron Diesel Advantage must be selected under CFN Network
Options (See #9 below).

l Other Gascard Cards: Fuelman & Gascard must be selected under ISO Based (See #9 below).

l All Fuelman Cards: Fuelman & Gascard must be selected under ISO Based (See #9 below).

9. Merchant Information: Enter your Site or Merchant ID in this field.

Other fields under this heading include:

l Originator ID

l Header String

l Card Acceptor Name

10. CFN Network Options/ISO Based: These options let you process additional cards on the CFN
network. It is recommended that merchant/site owner check with a CFN representative to determine
which cards can be enabled for acceptance.

NOTE: To process T-Chek MasterCard Fleet and ISO based cards, they must enabled in the
ISO table. For more information about the ISO Table, see the section Network
Management > ISO Table in M00-051.00 FSC3000 Command-Line Configuration.

11. CFN Batch Processing: The CFN Network supports transaction processing in batches. Select the
Batches button to configure CFN Batch Processing. The CFN Batch Processing pop-up will come into
view.
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l Number of transactions per batch: Once this number of transactions is reached the controller will
close the current batch on the CFN host. Enter the applicable number in the field.

l Max number of transactions if batch could not close: Maximum number of transactions allowed
before the system will stop processing CFN network related cards when a batch cannot be closed.
Enter the applicable number in the field.

l Time to open new batch: The time at which a batch will be closed regardless of the current number of
transactions. Typically used for end-of-day closure. Select a time from the time selector ( ).

P97 Merchant ID Information: To use a P97 mobile app to process fuel sales, select the Allow P97 Mobile
App Fuel Sales check-box.

l Enter the applicable P97 Store ID: See the note below

l Enter the applicable P97 Merchant ID: See the note below

NOTE: The Merchant ID number is given to the customer by Fleetcor. Confirm with Fleetcor
that the site has been enabled on the P97 network for processing. Enter the Merchant ID into
the field. When this configuration is saved, the data is sent to the P97 network and when
correctly connected, the Store ID will show. If the connection is not made, you will see a "Bad
Request" error message at the bottom of the screen.

IMPORTANT: If you deselect the check from the Allow P97 Mobile App Fuel Sales check-
box, and then select Save, a message will be sent back to the P97 network to turn off all
dispensers on the site. P97 will see that the site is now inactive.

Select the Allow P97 Mobile App Fuel Sales check-box again to re-link the site and resend
the data when you select Save.

Click Save to save the Network Information configuration during site edit.
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6.4.4 COMDATA and Comdata POS

1. Select Comdata from the Network drop-down. The parameters for Comdata network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: (Comdata only, not available for Comdata POS). Select the Allow Local
Authorization check-box to enable the Local Authorization option. The Local Authorization option
allows configuration of processing rules if the FSC3000 can authorize network cards offline when the
host is down. Not all networks support this feature. If you enable Local Authorization for a specific host
you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. Comdata Network Options: These check-box selections enable the different MasterCard Fleet
cards defined by Comdata for the applicable North American markets to process to this host (when the
MasterCard Fleet card is enabled in the ISO table). For more information about the ISO Table, see the
section Network Management > ISO Table in M00-051.00 FSC3000 Command-Line
Configuration.

Click Save to save the Network Information configuration during site edit.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 117

https://dover.sharepoint.com/:b:/r/sites/DFS-SSO/KB/FMS Technical Library/M00-051.00 FSC3000 Command-Line Configuration.pdf?csf=1&web=1&e=tjzE0C
https://dover.sharepoint.com/:b:/r/sites/DFS-SSO/KB/FMS Technical Library/M00-051.00 FSC3000 Command-Line Configuration.pdf?csf=1&web=1&e=tjzE0C


6.4.5 Company Card

1. Select Company Cardfrom the Network drop-down. The parameters for Company Card network
configuration will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.
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5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Merchant Information: Enter your Site or Merchant ID in this field.

Click Save to save the Network Information configuration during site edit.
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6.4.6 EFS

1. Select EFSfrom the Network drop-down. The parameters for EFS network configuration will come into
view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.
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8. Local Authorization: (Comdata only, not available for Comdata POS). Select the Allow Local
Authorization check-box to enable the Local Authorization option. The Local Authorization option
allows configuration of processing rules if the FSC3000 can authorize network cards offline when the
host is down. Not all networks support this feature. If you enable Local Authorization for a specific host
you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. EFS Network Options: When transactions are processed through an Abierto IP converter this option
must be selected. It tells the FSC3000 to analyze responsiveness to whether the transactions are
being processed over IP or dial-up fallback (when an IP connection cannot be made). When an IP
connection is made, the FSC3000 knows that modem based protocol controls are not supported so it
should not process the packets as such. For more information about the Abierto IP converter, see
M00-20-6013 -IP Authorization Gateway Procedure Guide.

Click Save to save the Network Information configuration during site edit.
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6.4.7 Federated Co-op

1. Select Federated Co-opfrom the Network drop-down. The parameters for Federated Co-op network
configuration will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: Select the Allow Local Authorization check-box to enable the Local
Authorization option. The Local Authorization option allows configuration of processing rules if the
FSC3000 can authorize network cards offline when the host is down. Not all networks support this
feature. If you enable Local Authorization for a specific host you should first confirm with the host that
this feature is allowed for the specific site. For more information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. Federated Co-op Network Options:

Synchronize Clock with Host: Select this check-box to sync the site clock with the TCH host.

Click Save to save the Network Information configuration during site edit.
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6.4.8 FleetOne

1. Select EFSfrom the Network drop-down. The parameters for EFS network configuration will come into
view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: (Comdata only, not available for Comdata POS). Select the Allow Local
Authorization check-box to enable the Local Authorization option. The Local Authorization option
allows configuration of processing rules if the FSC3000 can authorize network cards offline when the
host is down. Not all networks support this feature. If you enable Local Authorization for a specific host
you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. FleetOne Network Options: When transactions are processed through an Abierto IP converter this
option must be selected. It tells the FSC3000 to analyze responsiveness to whether the transactions
are being processed over IP or dial-up fallback (when an IP connection cannot be made). When an IP
connection is made, the FSC3000 knows that modem based protocol controls are not supported so it
should not process the packets as such. For more information about the Abierto IP converter, see
M00-20-6013 -IP Authorization Gateway Procedure Guide.

Click Save to save the Network Information configuration during site edit.
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6.4.9 Intevacon

1. Select Intevaconfrom the Network drop-down. The parameters for Intevacon network configuration
will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.
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5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Merchant Information: Enter your Site or Merchant ID in this field.

Click Save to save the Network Information configuration during site edit.
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6.4.10 Irving Oil

1. Select Irving Oil from the Network drop-down. The parameters for Irving Oil network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: (Comdata only, not available for Comdata POS). Select the Allow Local
Authorization check-box to enable the Local Authorization option. The Local Authorization option
allows configuration of processing rules if the FSC3000 can authorize network cards offline when the

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 128



host is down. Not all networks support this feature. If you enable Local Authorization for a specific host
you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. Irving Oil Network Options: Select the applicable options:

l Synchronize Clock with Host: Select this check-box to sync the site clock with the TCH
host.

l Process TCH Mastercard Fleet

l Present PPU (Price per unit) Continue prompt for all TCH issued cards

l Present PPU Continue prompt for Irving issued FPS cards

l Present PPU Continue prompt for Shell issied FPS cards

Click Save to save the Network Information configuration during site edit.
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6.4.11 Kardtech

1. Select Kardtech from the Network drop-down. The parameters for Kardtech network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: Select the Allow Local Authorization check-box to enable the Local
Authorization option. The Local Authorization option allows configuration of processing rules if the
FSC3000 can authorize network cards offline when the host is down. Not all networks support this
feature. If you enable Local Authorization for a specific host you should first confirm with the host that
this feature is allowed for the specific site. For more information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

Click Save to save the Network Information configuration during site edit.
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6.4.12 NBS BANK

1. Select NBS BANKfrom the Network drop-down. The parameters for NBS BANK network configuration
will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Merchant Information: Enter your Site or Merchant ID in this field.
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9. NBS BANK Network Options: This feature allows the merchant/site owner to restrict fueling and/or
meet requirements (for required fuel training) before allowing credit cards to be processed at an
unattended site.

INFORMATION: For a full explanation about the options in this panel, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #13
Force Bankcard Secur i ty Code in M00-051.00 FSC3000 Command-Line Configuration.

10. AVS (Address Verification Service) Prompting: This option enables the prompting of ZIP Code
and/or House Number prompting. This network can be set up to prompt as a theft deterrent only. To
enable this feature, select the AVS Prompts button. The Address Verification Service(AVS) Prompts
pop-up will come into view. See "Address Verification Service" on page 191.

INFORMATION: For a full explanation about the options in this pop-up, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #14
AVS Prompt ing in M00-051.00 FSC3000 Command-Line Configuration.

Click Save to save the Network Information configuration during site edit.
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6.4.13 NBS/FMGC (Fuelman/Gascard)

1. Select NBS/FMGCfrom the Network drop-down. The parameters for NBS/FMGC network
configuration will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: Select the Allow Local Authorization check-box to enable the Local
Authorization option. The Local Authorization option allows configuration of processing rules if the
FSC3000 can authorize network cards offline when the host is down. Not all networks support this
feature. If you enable Local Authorization for a specific host you should first confirm with the host that
this feature is allowed for the specific site. For more information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. NBS/FMGC Network Options:

When the FSC3000 processes Fuelman\Gascard cards to this host and, 1) it’s a private/customer controller
site where, 2) all Gascard cards are assigned to a specific customer account and, 3) the site chooses to
enable keyboard entry; this option can be used to allow the Gascard specific cards to be keyed in strictly
based on the embossed 6-digit number.

To configure this option:

Enter the 11 digit number that precedes the 6 digit card number embossed on the FuelMan/GasCard card
intended for keyed entry. Enter an alpha character to clear the string.

NOTE: Entering an alpha character allows the merchant to clear this setting from use.

Click Save to save the Network Information configuration during site edit.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 135



6.4.14 OPW Generic

1. Select OPW Genericfrom the Network drop-down. The parameters for OPW Generic network
configuration will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: Select the Allow Local Authorization check-box to enable the Local
Authorization option. The Local Authorization option allows configuration of processing rules if the
FSC3000 can authorize network cards offline when the host is down. Not all networks support this
feature. If you enable Local Authorization for a specific host you should first confirm with the host that
this feature is allowed for the specific site. For more information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. OPW Generic Network Options:

Synchronize Clock with Host: Select this check-box to sync the site clock with the TCH host.

Click Save to save the Network Information configuration during site edit.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 137



6.4.15 Paymentech

1. Select Paymentech from the Network drop-down. The parameters for Paymentech network
configuration will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Merchant Information: Enter your Site or Merchant ID in this field.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 138



9. Paymentech Network Options: This feature allows the merchant/site owner to restrict fueling and/or
meet requirements (for required fuel training) before allowing credit cards to be processed at an
unattended site.

INFORMATION: For a full explanation about the options in this panel, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #13
Force Bankcard Secur i ty Code in M00-051.00 FSC3000 Command-Line Configuration.

10. AVS (Address Verification Service) Prompting: This option enables the prompting of ZIP Code
and/or House Number prompting. This network can be set up to prompt as a theft deterrent only. To
enable this feature, select the AVS Prompts button. The Address Verification Service(AVS) Prompts
pop-up will come into view. See "Address Verification Service" on page 191.

INFORMATION: For a full explanation about the options in this pop-up, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #14
AVS Prompt ing in M00-051.00 FSC3000 Command-Line Configuration.

Click Save to save the Network Information configuration during site edit.
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6.4.16 Quarels

1. Select Quarels from the Network drop-down. The parameters for Quarels network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: Select the Allow Local Authorization check-box to enable the Local
Authorization option. The Local Authorization option allows configuration of processing rules if the
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FSC3000 can authorize network cards offline when the host is down. Not all networks support this
feature. If you enable Local Authorization for a specific host you should first confirm with the host that
this feature is allowed for the specific site. For more information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. Quarels Network Options: This feature allows the merchant/site owner to restrict fueling and/or
meet requirements (for required fuel training) before allowing credit cards to be processed at an
unattended site.

INFORMATION: For a full explanation about the options in this panel, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #13
Force Bankcard Secur i ty Code in M00-051.00 FSC3000 Command-Line Configuration.

11. AVS (Address Verification Service) Prompting: This option enables the prompting of ZIP Code
and/or House Number prompting. This network can be set up to prompt as a theft deterrent only. To
enable this feature, select the AVS Prompts button. The Address Verification Service(AVS) Prompts
pop-up will come into view. See "Address Verification Service" on page 191.

INFORMATION: For a full explanation about the options in this pop-up, see the section
Network Management > Host Speci f ic Setup Opt ions > Paymentech > #14
AVS Prompt ing in M00-051.00 FSC3000 Command-Line Configuration.
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Click Save to save the Network Information configuration during site edit.
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6.4.17 Quick Fuel

1. Select Quick Fuelfrom the Network drop-down. The parameters for Quick Fuel network configuration
will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: Select the Allow Local Authorization check-box to enable the Local
Authorization option. The Local Authorization option allows configuration of processing rules if the
FSC3000 can authorize network cards offline when the host is down. Not all networks support this
feature. If you enable Local Authorization for a specific host you should first confirm with the host that
this feature is allowed for the specific site. For more information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

Click Save to save the Network Information configuration during site edit.
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6.4.18 QUIKQ

1. Select QUIKQfrom the Network drop-down. The parameters for QUIKQ network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.
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5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Merchant Information: Enter your Site or Merchant ID in this field.

9. QUIKQ Network Options: Enter the required information:

l Password: This is the site password. The driver will be prompted at the terminal when the
Station Code is entered.

l PinCode: This is the site PinCode. The driver will be prompted at the terminal when the
Station Code is entered.

l Port: Select a Communication Port from the drop-down.

Click Save to save the Network Information configuration during site edit.
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6.4.19 Shell Canada

1. Select Shell Canada from the Network drop-down. The parameters for Shell Canada network
configuration will come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: (Comdata only, not available for Comdata POS). Select the Allow Local
Authorization check-box to enable the Local Authorization option. The Local Authorization option
allows configuration of processing rules if the FSC3000 can authorize network cards offline when the
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host is down. Not all networks support this feature. If you enable Local Authorization for a specific host
you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. Shell Canada Network Options: Select the applicable options:

l Synchronize Clock with Host: Select this check-box to sync the site clock with the TCH
host.

l Process TCH Mastercard Fleet

l Present PPU Continue prompt for all TCH issued cards

l Present PPU Continue prompt for Irving issued FPS cards

l Present PPU Continue prompt for Shell issied FPS cards

Click Save to save the Network Information configuration during site edit.
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6.4.20 TCH

1. Select TCHfrom the Network drop-down. The parameters for TCH network configuration will come into
view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: (Comdata only, not available for Comdata POS). Select the Allow Local
Authorization check-box to enable the Local Authorization option. The Local Authorization option
allows configuration of processing rules if the FSC3000 can authorize network cards offline when the
host is down. Not all networks support this feature. If you enable Local Authorization for a specific host
you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. TCH Network Options: Select applicable options:

l Synchronize Clock with Host: Select this check-box to sync the site clock with the TCH
host.

l Process T-CHECK Mastercard Fleet: Select the Process MasterCard Fleet check-box
so the FSC3000 can send TCH MasterCard Fleet cards to the TCH host. MasterCard
Fleet card must be enabled in the ISO table.To process T-Chek MasterCard Fleet and ISO
based cards, they must enabled in the ISO table. For more information about the ISO
Table, see the section Network Management > ISO Table in M00-051.00 FSC3000
Command-Line Configuration.

Click Save to save the Network Information configuration during site edit.
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6.4.21 T-CHEK

1. Select T-CHEKfrom the Network drop-down. The parameters for T-CHEK network configuration will
come into view.

2. Connect Time: The Connect Time option defines the maximum time to stay connected to the network
when trying to approve a card. If this time is reached, the transaction will be terminated. The default is
30 seconds.

3. Reprompt Time: The Re-Prompt Time option defines how long the system will look back for
transactions with the currently swiped card. If a transaction is found, the system will populate certain
fields with the same information as before. This setting is useful, for example, when a driver forgets to
bring his odometer and must go back to get it. By that time, the transaction has terminated. The driver
can then just swipe the card again and make sure the information shown on the screen is correct.

NOTE: DTC systems should be set to zero (0).

4. Connect Retries: The Connect Retries is the number of times the FSC3000 will attempt to reconnect
with the host after a timeout. The default is 1. If two phone numbers are stored in the Fleet Table, the
retries will also occur for the second number.

5. Auth(orization) Message: The Authorization Message is the message that will be shown at the
terminal after the network card has been approved (when the host itself did not return an authorization
message). You can keep the default or type in a new message. The default is 16 characters.

6. On/Off Times: This option defines when a specific network can process cards at the site. These times
can only be set within the Open/Close times of the site. Use the Time Selectors ( )to enter the On
Time and Off Time.

7. Comm(unication Parameters): Select the Comm button to open the Communications Parameters
screen. Host communication parameters are set as needed on cold start. If a network is added after
installation, it is possible that the communications parameters must be changed. If an Abierto/Systech
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IP Convertor is in use, make sure the network is using the same parameters. Select the available
parameters from the applicable drop-downs. Click the OK button to save the communication
parameters.

8. Local Authorization: (Comdata only, not available for Comdata POS). Select the Allow Local
Authorization check-box to enable the Local Authorization option. The Local Authorization option
allows configuration of processing rules if the FSC3000 can authorize network cards offline when the
host is down. Not all networks support this feature. If you enable Local Authorization for a specific host
you should first confirm with the host that this feature is allowed for the specific site. For more
information see "Local Auth(orization)" on page 192.

DEPENDENCY: Network Local Authorization Offline limits can be configured under "Fleet
/Account" on page 102

When Allow Local Authorization is selected, additional fields come into view:

l Infinite local authorizations allowed: There is no limit to the number of transactions that can be
made when Local Authorization is used.

l Allow keyed entry of card number: Select this check-box to let the driver enter a card number on the
keypad. Risk is increased when this feature is enabled.

l Max. Local Auth: You can specify a limit to the number of transactions that can be made when
Local Authorization is used.

l Duration: The number of minutes allowed.

9. Merchant Information: Enter your Site or Merchant ID in this field.

10. T-CHEK Network Options:

Select the Process MasterCard Fleet check-box so the FSC3000 can send TCH MasterCard
Fleet cards to the TCH host. MasterCard Fleet card must be enabled in the ISO table.

To process T-Chek MasterCard Fleet and ISO based cards, they must enabled in the ISO table.
For more information about the ISO Table, see the section Network Management > ISO
Table in M00-051.00 FSC3000 Command-Line Configuration.

Click Save to save the Network Information configuration during site edit.
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6.5 System Configuration
Set t ings > System Conf igura t ion

System Configuration Main Menu

This menu contains 10 tabs to configure parameters for your organization. These parameters are common to
all sites.

6.5.1 Products
Select Products from the System Configuration Main Menu.

There are two (2) tabs on this page to configure (Product Units) and (Product Types).

6.5.1.1 Unit
The units you enter into these fields are used for product configuration.

l Enter the applicable Units of measure for three units.

l Click the Save button to save this configuration.
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l Click Type to go to the "Type" tab.

6.5.1.2 Type

l Select a product from the list on the left side of the screen. Up to 32 products can be configured.

l The Product Setup and Network Setup parameters are automatically populated with the NACS (see
"National Association of Convenience Stores" on page 192) Product Code and all of the network code
fields.

NOTE: To get a complete list of network product codes contact your network sales
representative.

l .Applicable parameters can be edited if necessary.

l Price Sign Product Grade support is limited to FeatureMedia™ displays. It is designed to update
each price sign face (up to 8 maximum) configured to a specific grade. With this setting you can map
the price sign grades to the FSC3000 products. When a price change occurs (in DX Fleet or the
command line interface), price updates should occur within 15 seconds.

NOTE: If price sign communications fail, an error message will be displayed on the
FSC3000's LCD display.

l Click the Save button to save this configuration.
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6.5.2 Restrictions
Select Restrictions from the System Configuration Main Menu. The restriction settings below are global to
your organization.

6.5.2.1 Product Restriction
The Product Restriction tab will open by default.

Product Restrictions let you control which products can be dispensed for cards and accounts defined within
the proprietary card file.

l Select a Product Code from the left side panel (00 - 15).

NOTE: The product code 00 is the code for "all products." This cannot be changed.

l Select the applicable Fuel Types from the right side panel.

l Click the Save button to save this configuration.
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DEPENDENCY: Product Restrictions set up in this screen will populate the Product
Restriction drop-downs in "Account Information" on page 28 and the "Account Information Tab"
on page 36.

To be active, the Product Restriction option must be selected in "Define Card Record" on the
next page.

6.5.2.2 Quantity Restriction
Select the Quantity Restriction tab.

Quantity Restrictions are used to specify volume or currency limits assigned to a card or an account defined
in the proprietary card file.

l Select the applicable radio button for Restrict by Volume, or Restrict by Currency.

NOTE: Restrictions are limited for each transaction.

l Enter an applicable value for the restriction for each numbered code field (00 - 15) .

NOTE: The code 00 is the code for "No Restriction." This cannot be changed.

l Click the Save button to save this configuration.

DEPENDENCY: Quantity Restrictions set up in this screen will populate the Quantity
Restriction drop-downs in "Account Information" on page 28 and the "Account Information Tab"
on page 36.
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To be active, the Quantity Restriction option must be selected in "Define Card Record" below.

6.5.3 Odometer Reasonability
Select Odometer Reasonability from the System Configuration Main Menu.

The Reasonability option is used to set a Reasonability Range for the miles traveled when a vehicle enters
the site to refuel. An entry is thought to be reasonable when the difference between the current entry and the
previous entry is within the programmed range.

l If the Allow Fueling if three bad odometer entries slider is enabled, fueling is permitted if the
odometer is out of the specified range.

l For each code number (01 - 15) enter a Minimum and Maximum to specify an odometer range.

l Click the Save button to save this configuration.

6.5.4 Define Card Record
Select Define Card Record from the System Configuration Main Menu.

This screen is used to set up the parameters for proprietary cards at your sites.
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For the selections to be enabled on this page, enable the Proprietary Card slider. When this feature is
activated, Magnetic Cards, ChipKey, RFID (see "Radio Frequency Identification" on page 193), Keyboard and
other entry methods will be issued for use at your sites. The selections in the two panels will then be
available.

Select all of the applicable parameters. For radio button selections, only one selection will be available. For
check box selections, select all that apply.

Use Single Entry System: Only one entry (driver, vehicle or either) is required to be validated to
successfully authorize a pump to dispense fuel.

l Select one of the radio buttons to set the single entry method:

n Driver entry only

n Vehicle entry only

n Driver or Vehicle entry

Use Dual Entry System: The Dual Entry security feature requires both Driver and Vehicle input to be
validated to successfully authorize a pump to dispense fuel. Select one of the radio buttons to set the Dual
Entry method:

l Driver and Vehicle Tracking - Non-Restricted : Account cross-fueling can be used. When different
accounts are used the transaction will be tracked to (select one of the radio buttons):

n Driver Specific Account

n Vehicle Specific Account

l lDriver and Vehicle Tracking - Restricted - With Global Driver or Vehicle Records: The transaction is
tracked to record with the assigned Account.

l Driver and Vehicle Tracking - Most Restricted - No Account cross-fueling: Driver & Vehicle must be in
the same Account.

Enable the Allow use of Single Entry support under Dual Entry System slider to turn this feature on.
This control is only active when one of the Dual Entry System selections is selected (see above).

DEPENDENCY: When this control is enabled, the card "Operates as Single Entry " slider
control will be available on the Cards > PCF Defaul ts > Driver Defaul ts and Cards >
PCF Defaul ts > Vehic le Defaul tsDetails pages. See "Driver Defaults" on page 30 and
"Vehicle Details" on page 32.

Card File Feature Options must be selected here to make them operational in other screens. Select all
applicable feature options:

l Account Number: A department or company identification number of up to four digits; cards can be
grouped together for allocation restriction or reporting by assigning them to the same account.

DEPENDENCY: Account Number must be selected to use "Tiered Pricing" on page 162.
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l Expiration Date: This option lets you select a date when the card will expire and no longer be
operational within the Fuel Site Controller.

DEPENDENCY: This option will only be available in the Add/Edit screens of Cards >
Driver/Vehicle Records when it is selected here. See "Driver/Vehicle Records" on page 40.

l Monthly Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against a
card each month, from midnight of the first day of the month to 11:59 p.m. on the last day of the month.

l Daily Allocation: This is the total dollar (monetary value) limit of fuel that can be drawn against acard
in a single 24-hour period, from midnight to 11:59 p.m.

DEPENDENCY: The Allocation options will only be available in the Add/Edit screens of
Cards> PCF Defaul ts>Account Detai ls /Dr iverDefaul ts/Vehic le Defaul ts,
Cards > Add/Edi t Accounts or Cards > Add/Edi t Dr iver/Vehic le Records when
they are selected here. See "Account Defaults" on page 28, "Driver Defaults" on page 30,
"Vehicle Defaults" on page 32, "Accounts" on page 35, "Driver/Vehicle Records" on page 40.

l PIN Number: Select this option to require the entry of a Personal Identification Number.

NOTE: Vehicle records can use a PIN unless a Dual Entry System method is selected.

n Card invalid after 3 bad PIN entries: When this option is selected, the system will lock cards
from use after three (3) incorrect PIN entries for a single swipe. This is not applicable to
accounts, only cards.

DEPENDENCY: This option will only be available in the Add/Edit screens of Cards >
Driver/Vehicle Records when it is selected here. See "Driver/Vehicle Records" on page 40.

l Odometer Reasonability: This option is used to set a Reasonability range for the miles traveled when
a vehicle enters the site to refuel. An entry is thought to be reasonable when the difference between the
current entry and the previous entry is within the programmed range.

n After this feature has been enabled, if this box is unchecked at a later time, a pop-up will come
into view that reads:
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Notice: Disabling this feature will remove the ability to configure Odometer Reasonability settings
for your PCF cards. If desired, odometer prompting can be preserved based on your current
setup.

Important: To fully support this change, you must reconfigure the Proprietary card setup on your
FSC3000(s) and Resend your card file. Until then, Odometer Reasonability will NOT be enforced
at your fueling locations. Any new cards added to your organization will NOT prompt for
odometer.

n Select one of the options:

v Preserve Odometer Prompting: Select this option if you want to turn off Odometer
Reasonability while prompting for odometer remains. The way your card file is
currently set up is also retained. To go back to Odometer Reasonability will require
that you reconfigure the Proprietary card setup in the FSC3000 and then, resend the
card file.

v Remove All Odometer Prompts: This option will remove Odometer Reasonability
and all odometer prompts.

v Cancel: This will send you back to the screen without changes. The Odometer
Reasonability check box will remain selected.

DEPENDENCY: When Odometer Resonability is checked on this screen, note that when
cards are edited or added under Cards > Create Driver/Vehic le Records, the slider
control Allow Odometer Entry("Allow Odometer Entry " on page 41) will show in the ON
position, but will be "grayed-out." This indicates that the Odometer Reasonability option check
box (above) has been selected and that all records have Odometer Reasonability in use. To
put the "Allow Odometer Entry" slider in operation for individual records, the check box
(above) must be deselected under Odometer Reasonability (you must select the "Remove All
Odometer Prompts" button in the pop-up message as shown above to deselect the check box
and to make the slider active under Create Driver/Vehic le Records.

See "Odometer Reasonability" on page 157 for information on how to configure the Minimum
and Maximum range values for each of the Odometer Resonability codes.

NOTICE: To prevent issues with cards in the DFS cloud, do not enable "Prompt for
Odometer" in other screens unless you have Odometer Reasonability enabled here.

DEPENDENCY: Odometer reasonability must be selected to use "Tiered Pricing" on page 162.

l Use two different media devices for driver/vehicle record authorization:If you use two media
devices, Monthly Allocations and Daily Allocations (above) will be disabled.
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DEPENDENCY: When this check-box is selected, FSC Presented Media 1 & 2 will be
available on the setup screens in Cards > PCF Defaul ts > Driver and Vehic le
Defaul t Set t ings and in the Add/Edit pages of Cards > Driver/Vehic le Records.
When this check-box is not selected, the Monthly and Daily Allocations will be available in
Cards > PCF Defaul ts > Driver and Vehic le Defaul t Set t ings and in the Add/Edit
pages of Cards > Driver/Vehic le Records and only if the Monthly and Daily Allocation
check-boxes are selected above. See "PCF Defaults" on page 28 and "Driver/Vehicle Records"
on page 40 for more information.

l Product Restriction: This option contains codes that are used to limit the products that can be used
by a vehicle.

DEPENDENCY: See "Product Restriction" on page 155 for Product Restriction configuration.

l Quantity Restriction: This option lets you limit the quantity dispensed for each transaction.

DEPENDENCY: See "Quantity Restriction" on page 156 for Quantity Restriction configuration.

l Driver/Vehicle/Account name: Lets you assign up to a 9 character name to cards or accounts.

l Prompt sequence: This option lets you add up to eight (8) prompts for each card type and account.
These added prompts can be set up to have a predefined input such as alphanumeric, numeric, yes/no
and hidden with a maximum number of inputs. As with network cards, you can capture and verify
prompt information for cards stored in the card record file.

n Verify 1: Can be applied using the same concept as a PIN.

n Verify 2: Can be applied using the same concept as a PIN.

n Verify 3: Can be applied using the same concept as a PIN.

n Force Min Prompt Length: Lets you set a minimum prompt length.

n Discard Leading Zeros: Removes leading zeros from numeric entries. This does not apply to
odometer and misc. prompt entries.

DEPENDENCY: Prompt Sequence must be selected for the Extended Prompts tab to be
available on the Account Default Settings, Driver Default Settings and Vehicle Default Settings
pages under Cards > PCF Defaul ts. See "Extended Prompts Tab" on page 29 for
Accounts, "Extended Prompts Tab" on page 32 for Driver and "Extended Prompts Tab" on
page 34 for Vehicle.

Additional Options
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The right panel contains selections to set up Voyager cards as proprietary. Use this selection if applicable.

IMPORTANT: Do not use this feature if you are running a bankcard host unless you are willing
to accept all payment for Voyager cards.

Also, the Additional Options panel has options for Gasboy cards that have an embedded Track 2 Tiered
pricing discount number. Because of the many different Gasboy Track2 formats available, the FSC3000 has
no knowledge of where to find the embedded tiered pricing code. Therefore, you can use DX Fleet to
configure the FSC3000 to identify the position within the card’s Track2 data that represents the Tiered
Discount indicator.

The Left or Right selections under "When converting Gasboy formatted cards, starting with four zeros drop
digits from" is given to allow customization to accommodate the maximum number of digits on the card.

l Click the Save button to save this configuration.

6.5.5 Tiered Pricing

IMPORTANT: To use tiered pricing, you must have either the Tiered Discounts flag, or the
Tiered Accounts flag (see "Set Tiered Discounts" and "Tiered Accounts" in the M00-051.00
FSC3000 Command-Line Configuration manual), or both tiered flags enabled on the
FSC3000.

The Tiered Accounts feature of the FSC3000 is designed to provide “Tiered Pricing" against cards that are
always processed to a host enabled within the FSC3000. When this feature is enabled, the FSC3000 forces
a specific prompt to always be presented before any other prompt that might normally occur for the card in
use.

Select Tiered Pricing from the System Configuration Menu.
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DEPENDENCY: To use Tiered Pricing, Odometer Reasonability (see "Odometer
Reasonability" on page 157) must be configured and Account Number and Odometer
Reasonability must be selected under "Define Card Record" on page 157. Allow Odometer
Entry must be selected under Cards > Add/Edit Driver/Vehicle Records (see "Driver/Vehicle
Records" on page 40). Note that when Odometer reasonability is enabled, the Allow Odometer
Entry slider is automatically enabled but is "grayed-out." This indicates that the Odometer
Reasonability option check box (above) has been selected and that all records have
Odometer Reasonability in use.

INFORMATION: For more information about Tiered Pricing, see "Set Tiered Discounts" and
"Tiered Accounts" in the M00-051.00 FSC3000 Command-Line Configuration manual.
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You can specify monetary values from 0.001 to 9.999 for each of up to 10 pricing "Tiers" for up to 32
products. Enter the applicable values directly in the fields of the Tiered Pricing Configuration. The page is set
up as a table with Products listed in rows and the tier values for each product in columns.

In order to use Odometer Entries when Tiered Accounts is enabled, set all minimum values to zero (0) and
maximum to nine (9) if Odometer Reasonability and Multiple Locations are not in use. If Odometer
Reasonability is in use, then the Tier and Odometer Reasonability table are shared when using codes 1-20.

l Click the field in the applicable tier value to place a cursor in the field. The cursor will blink to show that
the value in the field can be edited.

l Repeat the same procedure for all applicable tiers and products.

l Click the Save button to save this configuration.

6.5.6 Define Transaction Records

6.5.6.1 Options
l The first three options in the Transaction Configuration window include:

n Wrap Around: It is recommended to keep this option selected.

NOTE: If Wrap Around is enabled and the transaction buffer is full, the older transactions will
be over-written when new transactions are received.
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IMPORTANT: Data will be lost if not polled before wrap around occurs.

n Write Over: This option will cause failed or non-captured network transactions to be over-
written when Wrap Around is enabled. This option is recommended to be used with Network
authorizations.

NOTE: If this condition is disabled and a failed or non-captured transaction is encountered,
the transaction buffer will be flagged as full and the system will display SYSTEM BUSY
BUFFER FULL on the terminals.

n Save Unauthorized Users: This option lets you enable or disable whether the system stores
an unauthorized attempt to use the system as a transaction. If this option is disabled, the
system will ignore unauthorized user events. Only cases when a pump was activated by the
FSC3000 are recorded. If you do not use this option you might see a gap in the transaction
numbers. This option is for use with proprietary cards.

6.5.6.2 Display Fields
This section defines what fields are shown when transactions are printed, shown on the terminal screen or
sent to external programs.

Select the applicable fields to be shown.

6.5.6.3 Computer Format
l Send Prompts in Computer Format: Enable this feature if you will use additional prompting in the

proprietary card file or if a network prompt capture is desired.

l Computer Format Check Data in Header: When you transfer data to an external system in the
computer format an optional data check can be prefixed to the transaction header to provide greater
data integrity. The data check includes:

n The number of records

n The sum of the quantities for records.

l Click the Save button to save this configuration.

6.5.7 Receipt Body
Select Receipt Body from the Main Menu. The edit screen will come into view.
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A receipt contains a "Receipt Header and Trailer" (refer to "Receipt" on page 99 for more information) which
can be different for each site and a Receipt Body which is common to all sites. The receipt body can be up
to 20 lines long. If the Second Language feature is enabled, receipts can be issued in either language and
the Language drop down will be enabled. For each line of the receipt body, text (up to 10 characters) can be
printed along with optional data. The optional data is one of 37 different transaction variables such as card
number, product name, price, etc.

l Change any of the variables by selecting from the drop down. Change the text by entering it into the
provided field.

l Click the Save button to save this configuration.

NOTE: Receipt Body is specific to proprietary transactions only.

6.5.8 User String
Select User String from the System Configuration Main Menu. The edit screen will come into view.
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6.5.8.1 Create User Field Labels
This panel of the screen is used to enter your own field names on the Account and Card pages to collect data
for the specific records.

The User String option lets you specify custom labels for specific fields for use in the application.

NOTE: When this option is used a label must be entered for all fields.

Click the applicable field in the screen to place a cursor in the field. The cursor will blink to show that text in
the field can be edited.

Enter the applicable text. Up to 20 alphanumeric and special characters will be accepted.

l Card User 1 and Card User 2 fields are used for useful user data. Some suggested labels for these
fields are VIN # (see "Vehicle Identification Number" on page 195), Vehicle Class, Driver Phone
Number, Vehicle License Plate #, or whatever serves the best purpose.

l Account User 1 and Account User 2 fields help to gather useful information. Some suggested labels
for these fields are Discount Rate, Paid Through Date, Review Date, Alternate Contact Name, or
whatever serves the best purpose.

l The Miscellaneous Entry Title field lets you specify an accurate reference label to the numerical data
collected by the FSC3000’s Miscellaneous prompt.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 167



6.5.8.2 Create Proprietary Prompts.
When extended prompts are in use you can enter up to 4 prompts of your own, specifically used for
Proprietary Cards. Proprietart Prompts can be up to 50 characters.

NOTE: Proprietary Prompts cannot be used with an EMV (see "Europay MasterCard and Visa"
on page 192) terminal.

l Click the Save button to save this configuration.

6.5.9 Cards
Select Cards from the System Configuration Main Menu.

There are two (2) tabs on this page to configure Card Status codes and Card Types.

6.5.9.1 Card Status

This screen is used to specify card status codes. There are 16 codes (00 - 15). Codes 00 through 03 and 14,
15 are preset and cannot be configured. Codes 04 - 13 are user configurable. The codes in this table are
used to populate the drop-down in the Driver/Vehicle Records in the "Cards" menu (on the DX Fleet blue
Main Menu bar). A status of Valid (Code 00) specifies that this record can refuel. The other remaining values
will set a record's status to Invalid.

l Click the Save button to save this configuration.
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6.5.9.2 Card Types
Select the Card Types tab.

The Card Type table is used within the FSC3000 for control of processing rules. It provides the FSC3000
knowledge of what the card is to determine what networks are able to process and if the card is a PCI
controlled card type.

This card type table is also made available during transaction polling in the “MISC” field of the transaction CF
format.

NOTE: Not every card listed can be added to the ISO table for processing. Consult OPW-FMS
Tech Support to determine the proper use and configuration of ISO table card definition.

The table is a list of the defined Multi-trucking card type codes. Codes 6 -19 are the PCI controlled card
types.

l Click the Save button to save this configuration.
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6.5.10 ATG (Automatic Tank Gauge) Configuration
Select ATG Configuration from the System Configuration Main Menu.

Enter the applicable information to configure a site ATG console.

Click Save.

DEPENDENCY: The ATG Type drop-down is configured in "ATG Settings" on page 88.

NOTE: Contact your DFS representative for help with configuration of ATG sites.
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6.6 Pricing
Set t ings > Pr ic ing

There are two panels on this page. The panel on the left shows Current Product Price data. The Price field of
the Update Product Price panel on the right can be edited.

l Select an Active Site from the drop-down at the top right of the page. The products that have been
configured for Tanks (refer to "Tank and Pumps" on page 89) will come into view in the Current Product
Price panel on the left side of the page. Products will be identified by their Product ID and Description.
The left panel shows each product's current price.

l To set a price for a product type, go to the Update Product Price panel on the right side and enter the
applicable price value into the Price field for the applicable Product ID.

l Click the Send Price button to send the updated price information to the FSC3000.

l The latest product price information will show in the Last Updated Product Price panel.

l The Status field on the top right of the page will show if the Send Price was successful.
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6.7 Fuel Zones
Set t ings > Fue l Zones

DEPENDENCY: Fuel Zones must be configured here to populate the Fuel Zone drop-down
fields under Cards > PCF Defaul ts and Cards > Driver/Vehic le Records. See "PCF
Defaults" on page 28, "Driver/Vehicle Records" on page 40.

The Fuel Zones option in the Settings menu lets you configure lists in relation to geographic areas. This
feature lets you define rules as to where a card can get fuel and to help control the quantity of cards that are
managed at a specific site. This feature also helps to make the best use of the Card Level Memory in the
FSC3000.

The table of the "Fuel Zones" screen shows the Fuel Zones that have been configured for your organization.
It shows a Zone Name column and the sites that are included in that zone in the Zone Sites column.

To update a Fuel Zone in the table view, select the Edit ( ) icon under the Manage column for the
applicable Fuel Zone. To add a new Fuel Zone, click the Add ( ) button to open the Create Fuel Zone
page.

To add a new Fuel Zone, enter a Fuel Zone Name in the field. During Edit, the name selected in the previous
screen will show.
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l Select all applicable Sites in the Available Sites table in the left panel. Hold the Ctrl button on your
keyboard as you click to highlight items to select multiple items.

l Click Add at the top of the panel to move the selected items to the Selected Sites list in the right panel.

Click the Update button to save this configuration or Cancel to return to the Table View.
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6.8 Terminal Window
Set t ings > Termina l Window

This page is the command-line interface for DX Fleet that can be used for programming and maintenance
tasks. This page can be used by Technical Support and users familiar with the programming language.

The Terminal Window is used to open live communication to the site controller through DOS terminal
emulation. The terminal window can be used to change the settings of the fuel site controller such as the
price, add a pump or change display messages.

INFORMATION: To get information about programming the FSC3000 refer to M00-051.00
FSC3000 Command Line Configuration.

6.8.1 FSC Commands History

As of Revision 2, the FSC Commands History button was added. This will let a user see up to three of the
most used commands that occurred in the last 24 hours.

1. Select an Active Site from the drop-down.

2. Click the Connect button to connect to the site.

3. At the > command prompt, log in to the FSC3000 with your log in credentials.

4. The FSC Commands History button will change to FSC Commands.

Programming and data capture from the FSC3000 can now be done through the Terminal Window.

5. Select Yes from the Capture to File drop-down to save all Terminal Window activity.

6. Click the Download button to download the captured file.

7. Use the drop-downs at the right of the Terminal Window screen to customize the Background color,
Font Size and Font color of the Terminal Window.

8. Click the FSC Commands button to go to the Commands view.
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9. An Admin (or Admin created User) that is logged-in through the Terminal Window can get access to
all three (3) of the selections of the FSC Commands History:

n Show Card

n Show Transaction

n Download Configuration: This selection is used to see all of the "SHOW" commands that were
issued to configure the system.

NOTE: A logged-in user with a partial password log-in can only get access the Show
Card selection.

INFORMATION: Refer to the "Passwords" section of M00-051.00 FSC3000
Command-Line Configuration Manual for more information on how to set up
passwords for admins and users.

Select one (or more if applicable) of the available Commands.

10. Click the Run button. The list of selected command records will show in the table view with each
command's Created Date and Status.

NOTE: The records in this table view are only available for 24 hours from the time they are
requested . The system will remove these records after 24 hours.
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11. In the Manage column, you can select the Download ( ) icon of an applicable record to download it
to your machine.

Sample Downloaded Record for a Selected Show Card Command

12. Use the Previous button to go back to the Terminal Window view.
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6.9 Audit Log
The Audit Log menu item is available only to Admin users. This will show an audit of

1. Use the Date Selector to select a Start and End date. The DX Fleet application will show the complete
Audit Log for the selected date range.

2. Select the Module Name drop-down. This filter lets you select from three (3) modules; global, settings
and transactions. The table will adjust to show only selected Modules.

3. Select the Operation Type drop-down. This filter lets you see only selected operations in the table
view.

The Table View of the Audit Log will show:

l Date and Time

l Module

l Organization Name

l User Name

l Operation Type

l Operation Details

l Result
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Select the View ( ) icon under Transaction Details to see a complete view of the full transaction.
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Section 7 Support Menu
The items in this menu are primarily used by Technical and Global support.

"Onboarding" on the next page

"Mobile Support" on page 181

"Sync Transaction" on page 182

"Support View" on page 183

"Demo Suite" on page 184

"Notification Management" on page 185

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 179



7.1 Onboarding
The Onboarding screen has two tabs, Organization Information and Site Information.

The Organization Information tab shows the Organization ID, Organization Name, Address, City State,
Country and Device Type. If there is more than one Device Type available, a "Select" drop-down will show.

Once a Device has been selected, click the Login icon. Follow the prompts to log in to the selected
device.

The Site Information tab shows available organizations in the left panel. Search or scroll to select an
Organization. The Sites related to that organization will come into view in the right panel. Information
includes, Site ID, Site Name, City, Zip Code, State and Country.

To onboard a site, Click the icon and follow the prompts.
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7.2 Mobile Support
The Mobile Support menu item is available only to Admin users.

Select an Account(s) from the Account Selection drop-down and Record(s) from the record Type drop-
down.

Click the Filters button.

Select a Record #/Name from the filtered results in the left panel to edit. The selected Record Name will
come into view in the right panel where the Email ID can be entered or edited. Select the check-box under
"Mobile Support" to make this feature available for the selected record Name.
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7.3 Sync Transaction
The Audit Log menu item is available only to Admin users.

Select a Site from the drop-down. Select a Start Date and End Date from the Time Selector. Click Apply to
begin the Sync Transaction process
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7.4 Support View
The Support View shows all applicable Organizations, if there is a critical condition of a site's Edge device or
if an Organization's sites are in a Normal condition.

You can click on the red tile at the top of the page to filter all of the "Critical" Sites, click the green tile to filter
all the "Normal" Sites or you can use the Search bar at the top right of the screen. Results will begin to filter
as you type.

Select an Organization tile to go to a Site view that shows Site ID, Site Name, Edge Status, Service Engine
Status and service Engine Version.

NOTE: Service Engine Status and service Engine Version will only show for a site when its
Edge device shows in a normal, Online condition.
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7.5 Demo Suite
The Demo Suite is only used by developers to show features to selected internal personnel.
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7.6 Notification Management
Selected personnel have been permitted to have access to enter notifications for new versions and other
important messages when the application has been updated. These notifications can be useful to
communicate helpful information to customers and users.

The features of this Support Menu item are shown below.

There are two (2) tabs on the "Notification Management" screen:

l Create Notifications

l History

Create Notifications

1. Enter a Notification Title in the text field.

2. The bottom panel is the area where your information will be entered.

3. Undo and Redo buttons.

4. Use the Text Formatting buttons to apply formatting to the text you enter in the bottom panel.

5. Media buttons: You can add images and video to your notifications. Click one of these buttons to bring
up a dialogue to navigate to and upload media files that will show in the bottom panel.

6. Click the </> button to enter HTML code.

7. Click the Preview button to see a preview of what your notification will look like when published to the
application.

8. Click the Save Draft button to save your work to edit or publish later.

9. Click the Publish button to send the notification to the app to be seen by customers and users of the
app.

l When you click the Publish button a time selector will come into view. Select a Date Range for the
publication of the notification.
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l While the notification is active in the app, users will see the notification when they log in during the
date range that was selected above.

Users will see the notification once they log in. They have tow (2) options:

l Select the Read Later button. The notification will come into view the next time the user logs in.

l Select the Acknowledge button to close the notification. The notification will no longer show upon log
in. However, if the user wants to see the notification again they can click the Notifications (bell icon)
button in the top right of the screen. The Release Notifications selection in the pop-up will show all
remaining active notifications.

History

The History tab will show the notification Name, the Valid date range, and Status of the notification.

Under the Manage column for each record row there is a Clone button. Select this button to make a clone
copy of the notification in the selected row. It will open in the Create Notifications tab where it can be edited.
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Section 8 Help
Click the Help link in the Main Menu bar to get access to DX Fleet resources.

8.1 Contact Us
Under the Contact Us heading there are links for:

l dfsdxsupport@doverfs.com: Select this link to open an email dialogue where you can send an email to
the Technical Support team with your questions.

l Knowledge Base: Select this link to find more available resources.

l Submit a Request: Select this link to open a support request form. Fill out the form as completely as
possible before you submit.

8.2 Training Videos
A selection of training videos can be found in the bottom panel.
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Appendix A - AVI: Automatic Vehicle Identification
Use this appendix if you have AVI Installed at your site. Cross-references are used in this appendix to take
you to related manual sections.

INFORMATION: For information on the DFS AVI solution:

Download the sales brochure here.
Download the technical manuals for AVI from the FMS Technical Library here.

Edit Controller Information (see "Edit Controller Information" on page 86)
Set t ings > Si tes > Cont ro l le r > Ed i t Cont ro l le r Deta i l s

In the "Edit Controller Details" screen under Additional Options:

l Select the AVI check-box. Two controls become active:

n The Enter Odometer at FITcheck-box will be in its ON condition. Select this check-box if you
want drivers to be prompted to enter their odometer readings at the terminal. This is only for
vehicles with single tags only.

n A blue AVI button will come into view. Select this button to open the RFN Setup screen (see
"Radio Frequency Nozzle" on page 193).
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1. You can configure up to 99 RFN numbers on this screen

2. Hover over the applicable RFN# to be configured from the list panel and select its Edit icon.
Configurable fields for the selected RFN will come into view:

3. Configure the parameters for the selected RFN:

l The RFN# is automatically entered and cannot be changed.

l Enter the Serial Number of the applicable RFN in the RFN Serial Number field.

l Enter the applicable (user preference) interval (in seconds) for the Pause/Resume option in the
Inactivity Timeout field. The default value is three (3) seconds (to a maximum of 999 seconds).

IMPORTANT: The larger the value of the Inactivity Timeout, the greater the risk that a driver
can steal fuel. Therefore, it is recommended to use the default value of three (3) seconds to
prevent the possibility of theft.

l Select the Pause/Resume check-box if this option will be used. The "Pause/Resume" option lets the
driver stop fuel dispensing for a specified time and not close the sale.

NOTE: The "Pause/Resune" feature is only available for electronic dispensers. A value
entered in the Inactivity Timeout field will stop the pump after the specified timeout when used
with mechanical dispensers or electronic dispensers that do not use the Pause/Resume
feature.

4. Click Save.
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TIP: For more information on RFN programming, see the M1044-RFN RFN Programming
Startup guide.
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Appendix B - DX Fleet Glossary
Term/Acronym Meaning Information

ATG Automatic Tank Gauge

An electronic device that monitors the fuel and water
levels in a tank. An ATG is used with a network of
probes and sensors to monitor fuel parameters (e.g. tem-
perature, density) and data analysis to determine loss
through leaks or theft.

Auth Abbreviation for Author-
ize or Authorized

AVI Automatic Vehicle Iden-
tification

The OPW-FMS AVI system uses a system of wireless
electronic components that interface with an FSC 3000
Fuel Site Controller to protect sites during unattended
fueling operations by automatically capturing and trans-
mitting data.

AVS Address Verification Ser-
vice

An address verification service (AVS) is a service
provided by major credit card processors to enable mer-
chants to authenticate ownership of a credit or debit card
used by a customer.[1] AVS is done as part of the mer-
chant's request for authorization in a non-face-to-face
credit card transaction. The credit card company or issu-
ing bank automatically checks the billing address
provided by the customer to the merchant against the
billing address in its records, and reports back to the mer-
chant who has the ultimate responsibility to determine
whether or not to go ahead with a transaction.
(Wikipedia)

Dollar Auth(oriz-
ation)

When a bankcard (Visa, MasterCard) is swiped, the
FSC3000 will connect to the network and pre-authorize
before the cardholder can fuel. Pre-authorization occurs
since the final dollar amount of pay-at-the-pump trans-
actions are not known until the end of the sale. Under
Visa and MasterCard rules, issuing banks place a hold
on a card holder’s account for transactions originating
from an automated fuel system for $1. From an author-
ization perspective, the approval of a $1 pre-author-
ization request allows a transaction of $75 or $150
(depending on card type). These limits are defined by
Visa and MasterCard and when dollar authorization is
enabled, the FSC3000 controls these limits as defined.
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DPC Direct Pump Control
This is an electronic dispenser control solution that lets
the FSC3000 directly control electronic dispensers
through the manufacturer's dispenser protocol.

EMV Europay MasterCard
and Visa

EMV is a payment method based upon a technical stand-
ard for smart payment cards and for payment terminals
and automated teller machines which can accept them.
EMV originally stood for "Europay, Mastercard, and
Visa", the three companies that created the standard.
(Wikipedia)

FIT Fuel Island Terminal
A FIT is used in fleet applications to control fuel con-
sumption and deliver secure, accurate and reliable fuel
tracking for unattended fueling operations.

FSC Fuel Site Controller
Tracks and reports fueling transactions by driver and/or
vehicle and interfaces with a variety of authorization and
commercial fueling networks.

ISO
International Organ-
ization for Stand-
ardization

ISO/IEC 7812-1:2006 specifies a numbering system for
the identification of issuers of cards that require an
issuer identification number to operate in international,
interindustry and/or intra-industry interchange.

ISO Independent Sales
Organization

The payment card industry defines an ISO as an organ-
ization or individual that is not an Association member
(meaning not a Visa or MasterCard member bank), but
which has a bank card relationship with an actual Asso-
ciation member.

Local Auth(oriz-
ation)

Local Authorization is the same as a "store and forward"
technique in telecommunications. This is a technique in
which information is sent to an intermediate station
where it is kept and sent at a later time to the final des-
tination or to another intermediate station. The inter-
mediate station, or node in a networking context, verifies
the integrity of the message before forwarding it. In gen-
eral, this technique is used in networks with intermittent
connectivity, especially in the wilderness or envir-
onments requiring high mobility. It may also be prefer-
able in situations when there are long delays in
transmission and variable and high error rates, or if a dir-
ect, end-to-end connection is not available.
(Wikipedia)

NACS National Association of
Convenience Stores

NACS is the leading global trade association dedicated
to advancing convenience and fuel retailing.
(https://www.convenience.org/About-NACS
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PCF Proprietary Card File

Proprietary cards, also called private label cards,
are issued under a contractual agreement between fin-
ancial institutions and third parties, usually large retail-
ers, for the purpose of consumers transacting business
with that entity. (https://www.f-
dic.gov/regulations/examinations/credit_card/pdf_ver-
sion/ch2.pdf)

PCI Payment Card Industry

A sector within the financial industry that is responsible
for all electronic payments. As purchases are completed
through debit, credit, ATM, POS, prepaid and e-purse
systems, sensitive financial data is constantly being
transmitted to all parts of the world.

PCI DSS Payment Card Industry
Data Security Standard

The Payment Card Industry Data Security Standard
(PCI DSS) is a set of security standards designed to
ensure that ALL companies that accept, process, store
or transmit credit card information maintain a secure
environment. (https://www.p-
cicomplianceguide.org/faq/#1)

PIN Personal Identification
Number

A personal identification number (PIN number or PIN
code), is a numeric passcode used in the process of
authenticating a user accessing a system. (Wikipedia)

Pulser

A device connected to the dispenser meter that converts
the mechanical movement of the meter mechanism to
electrical pulses that control the dispenser’s electronic
display of the volume and cost of the fuel dispensed.
(Petroleum Equipment Institute)

Resonability

A restriction where a
vehicle can get fuel only
within a predetermined
mileage from the pre-
vious refuel.

Example: If the current odometer reading of a vehicle is
12,625 miles and the previous entry was 12,500, and
the vehicle’s System Code allows a minimum Reason-
ability range of 150 miles and a maximum Reasonability
range of 400 miles, then a 125-mile difference is not a
reasonable odometer entry and fueling will be denied.

RFID Radio Frequency Iden-
tification

Radio Frequency Identification uses electromagnetic
fields to automatically identify and track tags attached to
objects. An RFID system consists of a tiny radio
transponder, a radio receiver and transmitter. (Wiki-
pedia)

RFN Radio Frequency
Nozzle

This is a device attached to a fueling nozzle used to
read passive tags installed on a vehicle's fueling intake.
This enables an Automatic Vehicle Identification system
installed at a site to identify a vehicle set up in the sys-
tem approved to get fuel at that fueling location.
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SE Service Engine
An onsite process that runs on the Edge that allows DX
Fleet to interact with the FSC3000 for purposes of card
management, configuration and transaction polling.

SMS
Short Message Service,
frequently referred to as
a text message

A text messaging service component of most telephone,
Internet and mobile device systems. It uses stand-
ardized communication protocols that let mobile devices
exchange short text messages. (Wikipedia)

TCP/IP
Transmission Control
Protocol/Internet Pro-
tocol

The Internet protocol suite, commonly known as TCP/IP,
is the set of communications protocols used in the Inter-
net and similar computer networks. The current found-
ational protocols in the suite are the Transmission
Control Protocol and the Internet Protocol. (Wikipedia)

Tiered Pricing

The “Tiered Discounts” flag feature of the FSC3000 was
designed to support the tiered price code embedded in
the Track2 on existing Gasboy cards. However,
because of the many different Gasboy Track2 formats
available, the FSC3000 has no knowledge of where to
find the embedded tiered pricing code. Therefore, the
FSC3000 must be configured to identify the position
within the card’s Track2 data that represents the Tiered
Discount indicator.

Totalizer
Tracks the amounts of
fuel actually dispensed
by the pump.

Dispensers have a counter to track fuel dispensed. You
can set your Totalizer to the same number so you can
then do a periodic check to make sure the numbers
match. If not, it can be an indication that there can be a
calibration issue with the pump or that theft has
occurred.

TRN Transaction file
See "Export TRN File" on page 54 for information on TRN
file exports. See "TRN Download" on page 56 for inform-
ation on TRN file downloads.

USB Universal Serial Bus

Universal Serial Bus is an industry standard that estab-
lishes specifications for cables, connectors and pro-
tocols for connection, communication and power supply
between computers, peripherals and other computers.
(Wikipedia)

UTC Coordinated Universal
Time

Coordinated Universal Time or UTC is the primary time
standard by which the world regulates clocks and time.
It is within about 1 second of mean solar time at 0° lon-
gitude (at the IERS Reference Meridian as the currently
used prime meridian) such as UT1 and is not adjusted
for daylight saving time. It is effectively a successor to
Greenwich Mean Time (GMT). (Wikipedia)
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VIN Vehicle Identification
Number

a 17-character code that is unique to your vehicle. It's a
combination of numbers and letters that provides valu-
able info about your car including where your car was
made, the model year, type of vehicle, and other inform-
ation.
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Appendix C - Version Release Notes

Version Effective Release
Notes

3.0.0.0
MVP2 V85 12/15/2022

"Card Management" on page 39, "Export Button" on page 17 in all screens,
"Customer Release Notification" on page 17, Restart the Edge Device from
the UI (see "Manage Icons" on page 84), Odometer Reasonability
changes under "Define Card Record" on page 157.

3.0.0.0
MVP2 V72 9/13/2022 "Power BI Reports" on page 62

Service
Engine Ver-
sion
3.0.113

6/24/2022

Terminal Window Improvements, AVI support (see "If you have AVI (See
"Automatic Vehicle Identification" on page 191 for a description) installed at
your site, select this option. " on page 86, "Select the RFN# if applicable
(applicable to AVI systems only). Here, you can map the RFN numbers that
were set up under "Edit Controller Information" (see "AVI: Automatic Vehicle
Identification" on page 188 for information on how to configure RFN numbers
in an AVI system through DX Fleet." on page 95, "Edit Controller Information"
on page 86

3.0.0.0
MVP2 V60 6/24/2022

ARTWare Changes,"Audit Log" on page 177, Export TRN in "Scheduler"
on page 60, Terminal Window Improvements

3.0.0.0
MVP2 V44 4/8/2022 "Export TRN File" on page 54, Capture File for Terminal Window

2.2.0.0
MVP2 V35 1/25/2022 Help Screen with Videos

2.2.0.0
MVP2 V32 1/11/2022 Support Screen, Dashboard Changes to reflect the Live Site Status

2.2.0.0
MVP2 V31 12/15/2021 Capability to edit PCF transaction, Changes in UI to show the filtered

transaction and cards while editing and closing

2.2.0.0
MVP2 V26 10/13/2021

Multiple sites and Date Range option for Sync Trans Feature, Status for
Sync trans feature which shows the details of synced and failed trans-
actions

2.2.0.0
MVP2 V23 9/13/2021

Multiple sites and Date Range option for Sync Trans Feature, Status for
Sync trans feature which shows the details of synced and failed trans-
actions

2.2.0.0
MVP2 V22 8/31/2021 Card Reassign Feature, Active Org

2.1.0.0
MVP2 V19 8/30/2021

Terminal Window Improvements, New Reports (Report by site for Driver,
Report by Account, Pump Totals, Account card listing, Account for
product), Export Data multi select option, Mileage Reasonability, Mobile
option enable/disable, Transactions Auto Sync
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Version Effective Release
Notes

2.0.0.0
MVP2 V18 6/11/2021 "TRN Download" on page 56 ATG Service deleted

2.0.0.0
MVP2 V17 5/25/2021 ATG Feature, "Reprice" on page 55

IMPORTANT: It is possible that older software versions might not support all features.

M3052_r5 DX Fleet User Manual | Dover Fueling Solutions 197



Revisions - M3052

Revision # ECO/
Approval Effective Software Version Key Changes

5 PN 5/30/2023 3.0.0.0 MVP2 V85

Changes per team deep-dive
review, added screen shots and
additional user-friendly features,
updated and added Dependency
panels. Added network specific
instructions. Added appendix for
AVI. Reconfigured sections to align
with UI menu structure.

4 JC 12/15/2022 3.0.0.0 MVP2 V85

Card management, Odometer
changes, Export Data in all
screens, Customer Release Noti-
fication, Edge Restart from UI,
moved Audit Log to Settings menu
and Power BI Reports to Reports
menu. Updated Report descrip-
tions.

3 NA 9/26/2022 3.0.0.0 MVP2 V72

Power BI Report descriptions,
added instructions to configure .csv
report to display leading zeros for
newer versions of MS Excel,

2.1 NA 8/5/2022

Add Report Category Filter for
Power BI, add instructions to con-
figure .csv report to display leading
zeros.

2 2062 7/7/2022

Add: Audit Log, Export TRN under
Scheduler, Card Import, Custom
Export, Power BI Reports, FSC
Commands History in Terminal Win-
dow.

1 2029 4/18/2022

Update applicable UI changes, add
new menu items for Export TRN,
Reprice, Download TRN, Job
Status, Terminal Window, add'l
Report Detail types. New Support
Menu and Help

0 1853 2/2/2021 Initial release
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NOTE: It is possible that older software versions might not support all features
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